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ご注意書き 

 

１． 本資料に記載されている内容は本資料発行時点のものであり、予告なく変更することがあります。当社製品

のご購入およびご使用にあたりましては、事前に当社営業窓口で最新の情報をご確認いただきますとともに、

当社ホームページなどを通じて公開される情報に常にご注意ください。 
2. 本資料に記載された当社製品および技術情報の使用に関連し発生した第三者の特許権、著作権その他の知的

財産権の侵害等に関し、当社は、一切その責任を負いません。当社は、本資料に基づき当社または第三者の

特許権、著作権その他の知的財産権を何ら許諾するものではありません。 
3. 当社製品を改造、改変、複製等しないでください。 
4. 本資料に記載された回路、ソフトウェアおよびこれらに関連する情報は、半導体製品の動作例、応用例を説

明するものです。お客様の機器の設計において、回路、ソフトウェアおよびこれらに関連する情報を使用す

る場合には、お客様の責任において行ってください。これらの使用に起因しお客様または第三者に生じた損

害に関し、当社は、一切その責任を負いません。 
5. 輸出に際しては、「外国為替及び外国貿易法」その他輸出関連法令を遵守し、かかる法令の定めるところに

より必要な手続を行ってください。本資料に記載されている当社製品および技術を大量破壊兵器の開発等の

目的、軍事利用の目的その他軍事用途の目的で使用しないでください。また、当社製品および技術を国内外

の法令および規則により製造・使用・販売を禁止されている機器に使用することができません。 
6. 本資料に記載されている情報は、正確を期すため慎重に作成したものですが、誤りがないことを保証するも

のではありません。万一、本資料に記載されている情報の誤りに起因する損害がお客様に生じた場合におい

ても、当社は、一切その責任を負いません。 
7. 当社は、当社製品の品質水準を「標準水準」、「高品質水準」および「特定水準」に分類しております。また、

各品質水準は、以下に示す用途に製品が使われることを意図しておりますので、当社製品の品質水準をご確

認ください。お客様は、当社の文書による事前の承諾を得ることなく、「特定水準」に分類された用途に当

社製品を使用することができません。また、お客様は、当社の文書による事前の承諾を得ることなく、意図

されていない用途に当社製品を使用することができません。当社の文書による事前の承諾を得ることなく、

「特定水準」に分類された用途または意図されていない用途に当社製品を使用したことによりお客様または

第三者に生じた損害等に関し、当社は、一切その責任を負いません。なお、当社製品のデータ・シート、デ

ータ・ブック等の資料で特に品質水準の表示がない場合は、標準水準製品であることを表します。 
標準水準： コンピュータ、OA 機器、通信機器、計測機器、AV 機器、家電、工作機械、パーソナル機器、

産業用ロボット 
高品質水準： 輸送機器（自動車、電車、船舶等）、交通用信号機器、防災・防犯装置、各種安全装置、生命

維持を目的として設計されていない医療機器（厚生労働省定義の管理医療機器に相当） 
特定水準： 航空機器、航空宇宙機器、海底中継機器、原子力制御システム、生命維持のための医療機器（生

命維持装置、人体に埋め込み使用するもの、治療行為（患部切り出し等）を行うもの、その他

直接人命に影響を与えるもの）（厚生労働省定義の高度管理医療機器に相当）またはシステム

等 
8. 本資料に記載された当社製品のご使用につき、特に、最大定格、動作電源電圧範囲、放熱特性、実装条件そ

の他諸条件につきましては、当社保証範囲内でご使用ください。当社保証範囲を超えて当社製品をご使用さ

れた場合の故障および事故につきましては、当社は、一切その責任を負いません。 
9. 当社は、当社製品の品質および信頼性の向上に努めておりますが、半導体製品はある確率で故障が発生した

り、使用条件によっては誤動作したりする場合があります。また、当社製品は耐放射線設計については行っ

ておりません。当社製品の故障または誤動作が生じた場合も、人身事故、火災事故、社会的損害などを生じ

させないようお客様の責任において冗長設計、延焼対策設計、誤動作防止設計等の安全設計およびエージン

グ処理等、機器またはシステムとしての出荷保証をお願いいたします。特に、マイコンソフトウェアは、単

独での検証は困難なため、お客様が製造された最終の機器・システムとしての安全検証をお願いいたします。 
10. 当社製品の環境適合性等、詳細につきましては製品個別に必ず当社営業窓口までお問合せください。ご使用

に際しては、特定の物質の含有･使用を規制する RoHS 指令等、適用される環境関連法令を十分調査のうえ、

かかる法令に適合するようご使用ください。お客様がかかる法令を遵守しないことにより生じた損害に関し

て、当社は、一切その責任を負いません。 
11. 本資料の全部または一部を当社の文書による事前の承諾を得ることなく転載または複製することを固くお

断りいたします。 
12. 本資料に関する詳細についてのお問い合わせその他お気付きの点等がございましたら当社営業窓口までご

照会ください。 
 
注 1. 本資料において使用されている「当社」とは、ルネサスエレクトロニクス株式会社およびルネサスエレク

トロニクス株式会社がその総株主の議決権の過半数を直接または間接に保有する会社をいいます。 
注 2. 本資料において使用されている「当社製品」とは、注 1 において定義された当社の開発、製造製品をいい

ます。 



資料中の「日立製作所」、「日立XX」等名称の株式会社ルネサス テクノロジへの変更について

　2003年4月1日を以って三菱電機株式会社及び株式会社日立製作所のマイコン、ロジック、

アナログ、ディスクリート半導体、及びDRAMを除くメモリ（フラッシュメモリ・SRAM等）を含む

半導体事業は株式会社ルネサス テクノロジに承継されました。従いまして、本資料中には 

「日立製作所」、「株式会社日立製作所」、「日立半導体」、「日立XX」といった表記が残っておりま

すが、これらの表記は全て「株式会社ルネサス テクノロジ」に変更されておりますのでご理

解の程お願い致します。尚、会社商標・ロゴ・コーポレートステートメント以外の内容につい

ては一切変更しておりませんので資料としての内容更新ではありません。

ルネサステクノロジ ホームページ （http://www.renesas.com）

2003年4月1日

株式会社ルネサス テクノロジ

カスタマサポート部

お客様各位



ご注意

安全設計に関するお願い

1. 弊社は品質、信頼性の向上に努めておりますが、半導体製品は故障が発生したり、誤動作する場合があり

ます。弊社の半導体製品の故障又は誤動作によって結果として、人身事故、火災事故、社会的損害などを

生じさせないような安全性を考慮した冗長設計、延焼対策設計、誤動作防止設計などの安全設計に十分ご

留意ください。

本資料ご利用に際しての留意事項

1. 本資料は、お客様が用途に応じた適切なルネサス テクノロジ製品をご購入いただくための参考資料であ

り、本資料中に記載の技術情報についてルネサス テクノロジが所有する知的財産権その他の権利の実施、

使用を許諾するものではありません。

2. 本資料に記載の製品データ、図、表、プログラム、アルゴリズムその他応用回路例の使用に起因する損害、

第三者所有の権利に対する侵害に関し、ルネサス テクノロジは責任を負いません。

3. 本資料に記載の製品データ、図、表、プログラム、アルゴリズムその他全ての情報は本資料発行時点のも

のであり、ルネサス テクノロジは、予告なしに、本資料に記載した製品または仕様を変更することがあ

ります。ルネサス テクノロジ半導体製品のご購入に当たりましては、事前にルネサス テクノロジ、ルネ

サス販売または特約店へ最新の情報をご確認頂きますとともに、ルネサス テクノロジホームページ

(http://www.renesas.com)などを通じて公開される情報に常にご注意ください。

4. 本資料に記載した情報は、正確を期すため、慎重に制作したものですが万一本資料の記述誤りに起因する

損害がお客様に生じた場合には、ルネサス テクノロジはその責任を負いません。

5. 本資料に記載の製品データ、図、表に示す技術的な内容、プログラム及びアルゴリズムを流用する場合は、

技術内容、プログラム、アルゴリズム単位で評価するだけでなく、システム全体で十分に評価し、お客様

の責任において適用可否を判断してください。ルネサス テクノロジは、適用可否に対する責任は負いま

せん。

6. 本資料に記載された製品は、人命にかかわるような状況の下で使用される機器あるいはシステムに用いら

れることを目的として設計、製造されたものではありません。本資料に記載の製品を運輸、移動体用、医

療用、航空宇宙用、原子力制御用、海底中継用機器あるいはシステムなど、特殊用途へのご利用をご検討

の際には、ルネサス テクノロジ、ルネサス販売または特約店へご照会ください。

7. 本資料の転載、複製については、文書によるルネサス テクノロジの事前の承諾が必要です。

8. 本資料に関し詳細についてのお問い合わせ、その他お気付きの点がございましたらルネサス テクノロジ、

ルネサス販売または特約店までご照会ください。
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本マニュアルを使用する際には、以下の点に留意してください。

1. 本マニュアルは、全体または一部が予告なしに変更される場合があります。
2. 本マニュアルの一部または全部を（株）日立製作所の許可を得ることなく、複製ま
たは複写することはできません。

3. 日立は、本マニュアルに従って操作を行っている間の事故または他の原因によるユ
ーザの装置への損害については、責任を負いません。
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まえがき

日立デバッギングインタフェースの使用前に本マニュアルを必ずお読みくだ
さい。
ユーザーズマニュアルは、なくさないよう保管してください。
本システムの使用方法を十分理解してから、使用してください。

本書について
本書では、日立のマイクロコンピュータの開発ツールに対応したHitachi
Debugging Interface (HDI) の使用法について説明します。次章、「はじめに」
では、デバッグインタフェースについて簡単に紹介し、このインタフェース
のおもな特長を示します。

次の各章、「デバッグの準備」、「プログラムの表示」、「プログラムの実
行」、「プログラムの停止」、「変数の表示」、「メモリの操作」、「オー
バーレイ機能」、「関数の設定」および「ユーザインタフェースの構成」は、
HDIを使用したデバッグに関する“how to”ガイドです。

本マニュアルは､動作環境をIBM PC上のMicrosoft® Windows®95 operating
system 英語版として記述しています。

別冊のデバッグプラットフォームのマニュアルには、以下の内容が記載され
ています。

「セットアップ」には、コンピュータにシステムハードウェアおよびソフト
ウェアをインストールする手順、およびすべてのシステム要素が正しくイン
ストールされたかどうかを検証する手順が記載されています。

「チュートリアル」には、デバッグシステムの簡単な開始・実行方法、およ
び一般的なセッションでの各デバッガ機能の使用例が記載されています。

「xxxxxxの機能」(xxxxxxにはデバッグプラットフォームの名称が入ります)
には、ブレークポイントの変更やトレース設定情報などのデバッグプラット
フォーム特有なユーザインタフェースについて記載されています。
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前提事項
本書では、読者の方々に、C/C++プログラミング言語およびデバッグ対象プ
ロセッサ用のアセンブラニーモニックについての十分な知識があること、お
よびMicrosoft® Windows®アプリケーションの使用経験があることを前提とし
ています。

マニュアルの規約
本書には、以下の表記上の規約があります。

表 1  表記上の規約

表 記 意 味

[Menu->Menu Option] ’->’の付いた太字の表記は、メニューオプショ
ンを指定する場合に使用します
(例： [File->Save As...])。

FILENAME.C 大文字表記の名前は、ファイル名を指定する
場合に使用します。

“enter this string” 入力必須のテキストを指定する場合に使用し
ます(引用符“ ”は除く)。

キーキーキーキー + キーキーキーキー 必要なキーを押すよう指示する場合に使用し
ます。たとえば、CTRL+N は、CTRL キーを
押したまま Nキーを押すことを意味します。

Ü

(“手順”記号)

この記号は、必ず左端に記載されます。この
記号が使われる場合は、すぐ右に実行手順が
記載されていることを意味します。

商標
Microsoft®　およびWindows®、Windows®95、Windows®98、WindowsNT®
は、米国マイクロソフトコーポレーションの米国およびその他の国における
登録商標です。

IBM PCは、米国IBM社により管理されている計算機の名称です。

ELF/DWARFは、the Tool Interface Standards Committee で開発された、オブ
ジェクトフォーマットの名称です。

本マニュアルで使用されているすべての製品名またはブランド名は、それぞ
れの会社の商標または登録商標です。
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1章                                                               はじめに    1

1 はじめにはじめにはじめにはじめに
Hitachi Debugging Interface (HDI)は、日立のマイクロコンピュータ用に、C/C++
言語およびアセンブリ言語で書かれたアプリケーションの開発およびデバッ
グを簡単に行うためのグラフィカルユーザインタフェースです。アプリケー
ションを実行するデバッグプラットフォームのアクセス、計測、および変更
に関して、HDIは高機能でしかも直観的な手段を提供することを目的として
います。

おもな特長
l Windows®グラフィカルユーザインタフェースを用いたデバッグ
l 直観的なユーザインタフェース
l オンラインヘルプ
l 共通した表示と操作性

注１ インサーキットエミュレータ、または評価ボードとともにHDIを使用する場
合などには、デバッグプラットフォームのハードウェアの詳細について、別
冊の『デバッグプラットフォームのマニュアル』を参照してください。

注２ HDIはWindows®3.1では動作しません。
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2章                                                         システムの概要    3

2 システムの概要システムの概要システムの概要システムの概要
HDIはモジュール方式のソフトウェアシステムで、それぞれに独立したモジ
ュールを使用します。これらのモジュールは汎用グラフィカルユーザインタ
フェースへリンクされており、これにより、システムを構成するモジュール
に関係なく共通した操作性が得られます。

2.1 ユーザインタフェース
HDIグラフィカルユーザインタフェースは、ユーザにデバッグプラットフォ
ームを提供し、システムの設定および変更を可能にするWindows®対応のア
プリケーションです。Windows®アプリケーションの詳しい操作方法は、
Windows®標準のユーザーズマニュアルを参照してください。

2.2 データ入力
ダイアログボックスまたはフィールドに数値を入力する場合には、単純な数
値だけでなく式も入力できます。この式には、符号を含めたり、C/C++言語
の演算子を使用することができます。C/C++言語のデバッグをサポートする
オブジェクトDLLが使われている場合に、配列や構造体などのC/C++言語機
能を使用できます。

一部のダイアログボックスでは、終了アドレスを入力する際に値の前に+符
号を付けることによりアドレス範囲を入力することが可能です。
この場合、＋符号を付けて入力された値と先頭アドレスの和が、終了アドレ
スになります。

2.2.1  演算子

以下のC/C++言語演算子を使用できます。

+, -, *, /, &, |, ^, ~, !, >>, <<, %, (, ), <, >, <=, >=, ==, !=, &&, ||

2.2.2  データ形式

接頭コードのないデータ値は、[Setup->Radix]メニューオプションで設定さ
れたデフォルトの基数を使用していると見なされます。ただし、回数を入力
するところは例外で10進数の値をデフォルトにとります。

名前にはシンボルを使用できます。また、一重引用符で囲めば、ASCII文字
列を入力できます(例：’demo’)。

次の接頭コードを使用して、基数を指定できます。
O’ 8進
B’ 2進
D’ 10進
H’ 16進
0x 16進
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先頭コードに#文字を使用してレジスタ名を指定すると、そのレジスタの内
容を使用できます。次に例を示します。
#R1, #ER3, #R4L

2.2.3  精度

式の評価では、すべての数理演算は32ビット(符号付き)を使用して行われま
す。32ビットを超える値はすべて切り捨てられます。

2.2.4  式の例
Buffer_start + 0x1000
#R1 | B’10001101
((pointer + (2 * increment_size)) & H’FFFF0000) >> D’15
!(flag ^ #ER4)

2.2.5  シンボル形式

シンボルには、C/C++ベースの指定ができます。これにより、C/C++言語ソ
ースと同様な記述でシンボルの参照ができます。また、シンボルにはキャス
ト演算子をつけることができます。これにより、型変換後のデータを参照す
ることができます。ただし、以下のような制限事項があります。

･ ポインタ指定は4レベルまで可能です
･ 配列指定は3次元まで可能です
･ アドレス参照（’&’ ）の指定は1レベルのみ可能です
･ typedef名は使用できません

2.2.6  シンボル指定の例
Object.value // メンバの直接参照指定(C/C++)
p_Object->value // メンバの間接参照指定(C/C++)
Class::value // クラス指定付きメンバ参照指定(C++)
*value // ポインタ指定(C/C++)
&value // アドレス参照指定(C/C++)
array[0] // 配列指定(C/C++)
Object.*value // メンバへのポインタ参照指定(C++)
::g_value // グローバル変数参照指定(C/C++)
Class::function(short) // メンバ関数指定(C++)
(struct STR)*value // キャスト指定(C/C++)

2.3 ヘルプ
HDIには、Windows®標準のコンテキスト依存型ヘルプシステムが備わって
います。ヘルプを使用すると、デバッグシステムの使用法に関するオンライ
ン情報が表示されます。

F1キーを押すか、Helpメニューを介して、ヘルプを呼び出すことができま
す。

さらに、一部のウィンドウおよびダイアログボックスには、専用のヘルプボ
タンがあります。
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2.3.1  コンテキスト依存型ヘルプ

HDIで、特定の項目に関するヘルプを得るには、ヘルプカーソルを使用しま
す。ヘルプカーソルを有効状態にするには、SHIFT+F1キーを押すか、また
は、ツールバー上のボタンをクリックします。
SHIFT+F1キーを押すと、カーソルが変化して、“？”マークが現れます。次
に、ヘルプを必要とする項目上でクリックすると、適切な内容のヘルプが開
きます。
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3 デバッグの準備デバッグの準備デバッグの準備デバッグの準備
本章では、デバッグプラットフォームを、プログラムをデバッグできる状態
に設定するため、HDIで使用するすべての機能について説明します。
ここでは、デバッグプラットフォームの選択・構成方法、およびデバッグオ
ブジェクトファイルのダウンロード方法について説明します。

3.1 デバッグを行うためのコンパイル
C/C++言語ソースレベルでプログラムをデバッグするためには、プログラム
をデバッグオプションを指定してコンパイル、リンクする必要があります。
デバッグオプションを指定すれば、コンパイラ、リンケージエディタは、
C/C++言語プログラムのデバッグに必要な全情報をアブソリュートファイル
または管理情報ファイルに格納します。このことから、これらのファイルは
通常、デバッグオブジェクトファイルと呼ばれます。

注 デバッグ用のデバッグオブジェクトファイルを作成する際には、コンパイラ
およびリンケージエディタの両方で、デバッグオプションを指定しているこ
とを確認してください。

デバッグオブジェクトファイルにデバッグ情報が入っていない場合でも、そ
のファイルをHDIへロードできますが、C/C++言語ソースレベルでプログラ
ムをデバッグすることができず、アセンブラレベルのみとなります。

3.2 デバッグプラットフォームの選択
HDIを起動すると、起動メッセージとメインウィンドウを表示します。その
後、起動メッセージの表示をクリアし、Select Sessionダイアログボックスを
表示します。
Select SessionダイアログボックスでCreate a new session onオプションを選ん
だ場合は、リストから、使用するデバッグプラットフォームを選び、[OK]
ボタンをクリックしてください。
誤ったプラットフォームを選択してしまった場合は、[File->New Session...]
メニューオプションをクリックすることにより、プラットフォームを選択し
直すことが出来ます。

図 3.1　Select Sessionダイアログボックス

HDIはプラットフォームのプラグインモジュールをロードし、デバッグプラ
ットフォームとの連動を開始します。ターゲットモジュールがロードされた
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後、各種のハードウェアまたはデータ群を初期化します。初期化の進行にし
たがって、ステータスバーにステータスメッセージを表示します。デバッグ
プラットフォームが正常に初期化を終了すると、HDIはステータスバー上に
“Link up”を表示します。

3.3 デバッグプラットフォームの構成
プログラムをデバッグプラットフォームにロードする前に、デバッグプラッ
トフォームの構成を、開発するユーザシステムに合わせて設定しなければな
りません。設定しなければならない項目は、デバイスの種類、動作モード、
クロック速度、およびメモリマップです。プログラムをデバッグプラットフ
ォームにロードするには、ロード先に必ずメモリが必要なので、メモリマッ
プの設定は特に重要です。

3.3.1  設定

デバッグプラットフォームの構成を設定するには、 [Setup->Configure
Platform...]メニューオプションを選択します。Select Sessionダイアログボッ
クスで選択したデバッグプラットフォームに対応する設定ダイアログボック
スが表示されます。

注 デバッグプラットフォームで使用できる各機能についての詳細は、別冊の『デ
バッグプラットフォームのマニュアル』を参照してください。

3.3.2  マッピング

ユーザシステムを正しく反映したデバッグ環境に設定するため、メモリマッ
プを設定する必要があります。デバイスのアドレス空間内のどの領域が、
RAM、ROM、オンチップレジスタ、またはメモリなしの領域であるかを認
識している必要があります。

Debugging platform configurationダイアログボックスでデバイスタイプおよび
モードを選択すると、HDIは自動的に、選択したデバイスおよびプロセッサ
が稼働するモードに合わせてマップを設定します。たとえば、ROM、RAM
を内蔵したデバイスの場合は、デフォルトで、このデバイスのメモリマップ
内でROM領域およびRAM領域が設定されます。

内蔵メモリのないデバイスを使用する場合や、内蔵メモリの代わりに、ある
いは内蔵メモリに加えて外部メモリを備えたデバイスを使用する場合は、外
部メモリがあることをデバッグプラットフォームに設定する必要がありま
す。また、エミュレータを使用してデバッグする場合で、デバイス内部にも、
ユーザシステムの外部にも存在しないメモリをアドレスマップに使用したい
場合は、エミュレータから一部のエミュレーションメモリを、使用するアプ
リケーション用のアドレス空間にマップすることが可能です。

メモリマップの構成を編集するには[Memory->Configure Map...]メニューを
選択します。Select Sessionダイアログボックスで選択したデバッグプラット
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フォームにより、表示形態が異なります。デバッグプラットフォームにイン
サーキットエミュレータを使用した場合は、以下のように表示されます。

図 3.2　Memory Mappingウインドウ

「マップ設定」領域には、アドレス空間の現在のマッピング状況が表示され
ます。この領域には、アドレス空間に存在するすべてのアドレス範囲、およ
びそれらのアドレス範囲が設定されているメモリタイプがリスト表示されま
す。エミュレータに対して内部であるか外部であるか、およびアドレス範囲
がもつアクセス制限(例：読み出し専用や保護(アクセス不可)など)がリスト
表示されます。この領域には、HDIが自動的に設定した範囲とユーザ自身が
設定または変更した範囲が含まれます。

メモリマップに関する補足情報はSystem StatusウィンドゥのMemoryシート
に表示されます。「デバイス構成」領域には、Configure Platformダイアログ
ボックスで選択したデバイスタイプとモード、およびオンチップメモリの制
御設定に応じて自動的に構成された、デバイスのアドレス空間でのメモリ状
況が表示されます。「システムリソース」領域には、システムに使用可能な
リソースのマッピング状況が表示されます。たとえばエミュレータの場合、
この領域には、エミュレータメモリを割り付けたアドレス範囲、および現在
使用可能なエミュレータメモリが表示されます。

[Reset]ボタンをクリックすると、システムマップの設定内容が、現在のデバ
イスタイプおよびモード用のデフォルト設定に戻ります。

マップ設定を変更するには、対象の設定値を選択して、[Edit]ボタンをクリ
ックするか、または対象のマップ設定行をダブルクリックします。

マップ設定マップ設定マップ設定マップ設定
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図 3.3　Edit Memory Mappingダイアログボックス

ダイアログボックスで、マップ範囲の開始アドレスと終了アドレス、および
メモリタイプを設定できます。

新規に領域を追加するには、 [Add]ボタンをクリックしてAdd Memory
Mappingダイアログボックスを開きます(デフォルト値が未設定であることを
除いてEdit Memory Mappingダイアログボックスと同じです)。マップ範囲の
開始アドレスと終了アドレス、および新規領域のメモリタイプ設定を入力し
てください。新規領域が既存範囲の間にある場合、HDIは自動的に、新規領
域の範囲を調整します。

注 マップ設定時、エミュレータによって設定できる最小のアドレス範囲が異な
りますので、アドレス範囲が入力したアドレス値に一致しないことがありま
す。

3.3.3  ステータス

デバッグプラットフォームの構成や設定情報をチェックするには、[View-
>Status]メニューオプションを選択してSystem Statusウィンドウを開きま
す。
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図 3.4　System Statusウインドウ

System Statusウィンドウは、4枚のシートに分割されています。

･ Sessionシート
 接続しているデバッグプラットフォームおよびロードしたファイルの名
前など、現在のセッションに関する情報を含んでいます。

･ Platformシート
CPU種別および動作モードなど、デバッグプラットフォームのステータ
ス情報、実行状態およびクロック情報を含んでいます。

･ Memoryシート
メモリマッピングおよび現在ロードしたオブジェクト・ファイルによっ
て使用されるメモリエリアなど、現在のメモリステータスに関する情報
を含んでいます。

･ Eventsシート
リソース情報およびブレークポイント等のイベント情報に関する情報を
含んでいます。

ステータス情報を更新するためには、ポップアップメニューの[Update]メニ
ューオプションを選択してください。

3.4 プログラムのダウンロード
プログラムをダウンロードするシステム上に、必要なサイズのメモリを確保
したら、デバッグするプログラムをダウンロードしてください。[File->L oad
Program...]メニューオプションを選択すると、Load Programダイアログボッ
クスが開きます。



12      Hitachi Debugging Interface User’s Manual                                                                             

図 3.5　Load Programダイアログボックス

ダイアログボックスには、直近にロードされた4つのファイルのリストを持
つコンボボックス、オフセットアドレス（S-Recordのようにオフセット・ア
ドレスが使用できるオブジェクトフォーマットの場合）およびベリファイボ
タンがあります。ベリファイとは、プラットフォームへダウンロードされた
データが正しいかをリードバックしてチェックします。そのためダウンロー
ド速度が遅くなるので、メモリやリンクファイルに問題があるかを調べると
きにベリファイを行なうようにしてください。

コンボボックスにロードしたいファイルが含まれていない場合、編集エリ
アへファイル名を直接入力するか、Browseボタンを使用してロードしたい
ファイルを探索することができます。

図 3.6  Browse Program Fileダイアログボックス

ロードするファイルを選択するには、まず Browse Program Fileダイアログ
ボックスのFiles of typeフィールド内をクリックして、表示するファイルのタ
イプを選び、そのファイルタイプをクリックします。
Files of typeフィールドについては「11.6 ファイルフィルタのカスタマイズ」
を参照してください。

図 3.7　ファイルタイプの選択
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ファイルタイプを選択すると、指定したファイルタイプのファイルがファイ
ルリストに表示され、このリストからファイルを選択できます。ファイルリ
ストの右に表示される、標準ウィンドウのファイルオープンダイアログボッ
クスのコントロールを使用して、ディレクトリおよびドライブを変更するこ
とができます。また、File nameフィールドに直接ファイル名を入力すること
もできます。

[OK]ボタンは、Browserダイアログボックスで選択したプログラムのパスお
よびファイル名をFile nameフィールドにセットしてLoad Programダイアログ
ボックスに戻ります。

ファイルを選択した後、[Open]ボタンをクリックしてロードを開始します。
ダウンロード中は、ステータスバーに進行状況を表示します。
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4 プログラムの表示プログラムの表示プログラムの表示プログラムの表示
本章では、プログラムリストをソースコードやアセンブラニーモニックで表
示する方法について説明します。また、HDIを使用してコード、ラベル、テ
キストファイルを表示する方法について述べます。

注 ブレークが成立時、Sourceウィンドウにはプログラムカウンター(PC)の位置
を表示します。しかし、SYSROFオブジェクトフォーマットを使用したプロ
ジェクトの場合、そのオリジナルのパスからソースファイルが移動されてい
ると、自動的に見つけることができません。この場合は、現在のセッション
で以前に使用されたパスリストを検索します。それでもソースファイルが見
つからない場合、Source File Browserダイアログボックスをオープンするの
で、ソースファイルの存在するパスを指定してください。以降、ここで指定
したパスは自動的に検索します。

4.1 コードの表示

4.1.1  ソースコードの表示

プログラムのソースコードを見るには、[View->Source...]メニューオプショ
ンを選択するか、キーボードでCtrl+Kを入力します。あるいは、ツールバー
上にSourceボタン[ ] が表示されていれば、このボタンをクリックします。

ソースファイルを選択して[Open]をクリックすると、Sourceウィンドウが開
きます。

図 4.1　Sourceウィンドウ

Sourceウィンドウは、ヘッダバー領域とメインウィンドウ領域の、2つの領
域に分割されています。また、縦に、Line、Address、BP（Break Point）、Label
およびSourceの5つの列に分かれています。各列の幅を調整するには、ヘッ
ダバーに表示された各列のタイトル間の境界線をドラッグします。　カーソ
ルが に変わり、ドラッグした位置にあわせて、メインウィンドウ領域に

ヘッダバーヘッダバーヘッダバーヘッダバー

アドレスアドレスアドレスアドレス
フィールドフィールドフィールドフィールド

ブレークブレークブレークブレーク
ポイントポイントポイントポイント

ソースコードソースコードソースコードソースコード
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縦線が表示されます。変更したい列幅に合わせてマウスボタンを離すと、新
しい列幅で表示が更新されます。

4.1.2  アセンブラコードの表示

Sourceウィンドウがオープンされている場合は、ポップアップメニューの[Go
to Disassembly]メニューオプションを選択すると、Disassemblyウィンドウを
オープンします。Disassemblyウィンドウには、Sourceウィンドウに現在表示
されているアドレスと同一のアドレスを表示します。

ソースファイルがなく、アセンブラレベルでコードを表示したいという場合
は、[View->Disassembly...]メニューオプションを選択するか、キーボードで
Ctrl+Dを入力します。あるいは、ツールバー上にDisassemblyボタン[ ] が
表示されていれば、このボタンをクリックします。Set Addressダイアログボ
ックスには、逆アセンブルの開始アドレスを指定してください。

Disassemblyウィンドウにはアドレス、マシンコード値、ラベル、逆アセン
ブルされたニーモニック(使用可能であればラベル付きで)が表示されます。
さらに、対応するソースファイルを表示し、混在モード表示を提供します。

図 4.2　Disassemblyウィンドウ

4.1.3  アセンブラコードの変更

アセンブラコードを変更するには、変更したい命令をダブルクリックし、
Assemblerダイアログボックスを開きます。

図 4.3　Assemblerダイアログボックス

アドレス、マシンコード、および逆アセンブルされた命令が表示されます。
Mnemonicフィールドに新しい命令を入力するか、表示されている命令を変
更してください。[OK]をクリックするか、ENTERキーを押すと、その命令

アドレスアドレスアドレスアドレス

マシンコードマシンコードマシンコードマシンコード

逆アセンブル逆アセンブル逆アセンブル逆アセンブル
された命令された命令された命令された命令
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がアセンブルされてメモリに格納され、次の命令に移ります。[Cancel]をク
リックするか、ESCキーを押すと、このダイアログボックスが閉じます。

注 アセンブラ表示は、デバッグプラットフォームのメモリに格納された実際の
マシンコードから逆アセンブルされます。メモリの内容が変更されると、そ
れに対応する新しいアセンブラコードが示されます。ただし、この内容は、
ソース表示とは一致しません。

4.2 ラベルの表示
デバッグオブジェクトファイルに含まれるシンボル情報には、プログラム中
でアドレスを表す、ラベルが含まれています。ラベルは対応するアドレスの
Labelフィールドに表示されます。また、Assemblerフィールドにオペランド
の一部として表示されます。

注 命令のオペランドとラベルが一致する場合は、そのオペランドがラベルに置
き換えられます。2つ以上のラベルが同じ値をもつ場合は、アルファベット
順で最初にくるラベルが表示されます。

注 HDIでは、アドレスまたは値を入力できる場所では、どこでもラベルを代わ
りに使用できます。

4.2.1  ラベルのリスト表示

HDIで定義した全ラベルのリストを見るには、[View->Labels...]メニューオ
プションを選択して、Labelsウィンドウを開きます。
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図 4.4　Labelsウィンドウ

それぞれのカラムヘッダをクリックすることによって、アルファベット順
(ASCIIコード順)またはアドレスの昇順にソートします。

BP列をダブルクリックする(または、ポップアップメニューの [Break]メニ
ューオプションを選択する)により、対応するアドレスにソフトウェアブレ
ークを迅速に設定することができます。

4.2.2  Sourceウィンドウまたは Disassemblyウィンドウでのラベルの追加

SourceウィンドウまたはDisassemblyウィンドウで、ラベルを割り当てたいア
ドレスのラベル列をダブルクリックすることで、ラベルを迅速に追加するこ
とができます。Labelダイアログボックスで、ラベル名を入力してください。

図 4.5　Labelダイアログボックス

ラベル名を入力し[OK]をクリックすると、その行のアドレス列に表示され
ているアドレス値がラベルに設定され、ラベルリストに追加されます。Source
ウィンドウの表示内容が更新され、追加したラベルが表示されます。[Clear]
ボタンはラベルを削除するために使用します。

また、この方法を使用して、既存のラベルのテキストを簡単に変更すること
もできます。Label列で変更するラベルをダブルクリックすると、Labelダイ
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アログボックスのエディットボックスにそのラベルのテキストがコピーされ
ます。次に、そのテキストを変更すると、変更されたテキストがラベルリス
トに保存されます。Sourceウィンドウの表示内容が更新され、新しいラベル
が表示されます。

注 追加・変更したラベルを再度使用する場合は、ラベル情報をファイルに保存
してください。詳細は、「13.5.8 Save As …」を参照してください。

4.3 特定アドレスのプログラム表示
Sourceウィンドウでプログラムを参照時に、別の領域のプログラムを参照し
たいことがあります。その場合には、メインウィンドウ領域をスクロールす
るのではなく、特定のアドレスへ直接移動することができます。Address列
でダブルクリックすると、Set Addressダイアログボックスが開きます。

図 4.6　Set Addressダイアログボックス

該当するアドレスまたはシンボル名をエディットボックスに入力して、[OK]
をクリックするか、ENTERキーを押します。そのアドレスのコードが同じ
ソースファイル内にある場合は、Sourceウィンドウが新しいアドレスのコー
ドに更新されます。ただし、多重定義関数あるいはクラス名を入力した場合、
Select Functionダイアログボックスが開くので、設定する関数を選択してく
ださい。詳細については、「10 関数の設定」を参照してください。

新しいアドレスが別のソースファイル内にある場合は、新しいSourceウィン
ドウが開き、そのアドレスのコードが表示されます。ソースファイルが参照
可能であれば、デフォルトで新規ウィンドウにソースが表示されます。新規
アドレスに対して参照可能なソースファイルがない場合は、Sourceウィンド
ウはアセンブラコードで表示されます。

新しいアドレスが、すでに開いているSourceウィンドウのソースファイル内
にある場合は、そのウィンドウが前面に呼び出されて、新しいアドレスのコ
ードが表示されます。

4.3.1  現在の PCのプログラム表示

HDIにアドレスまたは値を入力できる場所では、式を入力することも可能で
す(「2.2 データ入力」を参照)。先頭に“#”文字を付けてレジスタ名を入力す
ると、そのレジスタの内容が値として式に使用できます。つまり、Set Address
ダイアログボックスを呼び出して、“#PC”という式を入力すると、Sourceウ
ィンドウまたはDisassemblyウィンドウには現在のPCのアドレスが表示され
ます。また、PC+オフセット (例：“#PC+0x100”)の形で式を入力して、現在
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のPCアドレスからオフセット値分はなれた箇所を表示することも可能で
す。

4.4 テキストの検索
検索オプションを使用して、Sourceウィンドウから特定の文字列を検索でき
ます。これを実行するには、ポップアップメニューの[Find...]メニューオプ
ションを選択するか、キーボードでSHIFT＋F10を押します。

Findダイアログボックスが表示されます。

図 4.7　Findダイアログボックス

検索したいテキストを入力して、[Find Next]をクリックするか、ENTERキ
ーを押します。テキストが検出されると、Sourceウィンドウにはそのテキス
トが反転表示されます。そのテキストが次に現れる箇所を検索するには、再
度、[Find Next]をクリックするか、ENTERキーを押します。Findダイアロ
グボックスを閉じるには、[Cancel]をクリックするか、ESCキーを押します。
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5 メモリの操作メモリの操作メモリの操作メモリの操作
本章では、CPUのアドレス空間で、メモリの各領域を見る方法について説明
します。ここでは、様々なフォーマットでメモリ領域を表示する方法、メモ
リブロックにデータを埋める方法、メモリブロックの移動およびテスト方
法、ディスクファイルを使用したメモリ領域の保存、ロード、およびベリフ
ァイ方法について述べます。

5.1 メモリ領域の表示
メモリ領域を見るには、[View->M emory...]メニューオプションを選択する
かCtrl+Mキーを押して、Memoryウィンドウを開きます。あるいは、ツール
バーにMemoryボタン[ ]が表示されていれば、このボタンをクリックして
Memoryウィンドウを表示することもできます。Open Memory Windowダイア
ログボックスが表示されます。

図 5.1　Open Memory Windowダイアログボックス

Addressフィールドに、ウィンドウ表示の開始アドレスまたはそれに相当す
るシンボルを入力して、Formatリストから必要な表示フォーマットを選択し
ます。[OK]をクリックするか、ENTERキーを押すと、このダイアログボッ
クスが閉じ、Memoryウィンドウが開きます。

図 5.2　Memoryウィンドウ(バイト単位)

Memoryウィンドウは、２つの表示列を持っています。

･ Data
 表示するデータはデバッグプラットフォームから読み込みます。データ
は表示サイズ単位に物理メモリから読み込みます。データの変更ができ
ます。
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･ Value
データは選択されたフォーマットで表示します。値の変更はできません。

表示フォーマットを、ウィンドウのオープン時に選択したものから変更した
い場合は、ポップアップメニューから変更できます。

5.1.1  ASCIIでのメモリ表示

メモリをASCII文字として表示・変更するにはポップアップメニューの
[ASCII]メニューオプションを選択します。[ASCII]メニューオプションを選
択すると、表示内容が更新され、メモリ内容がASCII文字で表示されます。

5.1.2  バイト単位でのメモリ表示

メモリをバイト単位で表示・変更するにはポップアップメニューの[Byte]メ
ニューオプションを選択します。[Byte]メニューオプションを選択すると、
表示内容が更新され、メモリ内容がバイト単位で表示されます。（図5-2）

5.1.3  ワード単位でのメモリ表示

メモリをワード単位で表示・変更するにはポップアップメニューの[Word]
メニューオプションを選択します。[Word]メニューオプションを選択する
と、表示内容が更新され、メモリ内容が16ビットのワード単位で表示されま
す。

5.1.4  ロングワード単位でのメモリ表示

メモリをロングワード単位で表示するにはポップアップメニューの [Long]
メニューオプションを選択します。[Long]メニューオプションを選択する
と、表示内容が更新され、メモリ内容が32ビットのロングワード単位で表示
されます。

5.1.5  単精度浮動小数点形式でのメモリ表示

メモリを単精度浮動小数点形式で表示するにはポップアップメニューの
[Single float]メニューオプションを選択します。[Single float]メニューオプシ
ョンを選択すると、表示内容が更新され、メモリ内容が単精度浮動小数点形
式で表示されます。

5.1.6  倍精度浮動小数点形式でのメモリ表示

メモリを倍精度浮動小数点形式で表示するにはポップアップメニューの
[Double float]メニューオプションを選択します。[Double float]メニューオプ
ションを選択すると、表示内容が更新され、メモリ内容が倍精度浮動小数点
形式で表示されます。

5.1.7  別領域のメモリ表示

Memoryウィンドウに表示されたメモリ領域を変更するには、スクロールバ
ーを使用できます。表示する領域を変更するには、Set Addressダイアログボ
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ックスを使用します。ポップアップメニューの[Set Address...]メニューオプ
ションを選択するか、またはアドレス列をダブルクリックすることで、この
ダイアログボックスを呼び出すことができます。

図 5.3　Set Addressダイアログボックス

Set Addressダイアログボックスが開いたら、新しいアドレス値を入力しま
す。[OK]をクリックするか、ENTERキーを押すと、このダイアログボック
スが閉じ、Memoryウィンドウの表示内容が更新され、新しいアドレスのデ
ータが表示されます。ただし、アドレス値として多重定義関数あるいはクラ
ス名を入力した場合、Select Functionダイアログボックスが開くので、設定
する関数を選択してください。詳細については、「10 関数の設定」を参照
してください。

5.2 メモリ内容の変更
アドレスのメモリ内容を変更する方法は2つあります。一つは簡易変更方式
です。本方式は、ウィンドウに値を直接入力できますが、ASCII表示時はASCII
入力のみ、それ以外での表示時は16進数値の入力のみに限定されます。もう
一つは、詳細変更方式です。本方式は、ダイアログボックスで値を入力しま
す。浮動小数点数や式を値として入力できます。

5.2.1  簡易変更方式

該当する桁をクリックするか、または、クリック・ドラッグにより変更した
い桁を選択し、反転表示させます。その桁に新しい値を入力してください。
値は、0-9およびa-fの範囲内でなければなりません。変更値がその桁に書き
込まれ、カーソルがメモリの次の桁へ移動します。

5.2.2  詳細変更方式

Editダイアログボックスを使用します。変更するメモリ単位（Memoryウィ
ンドウの表示フォーマットに依存します）上にカーソルを移動してENTER
キーを押す、またはダブルクリックすると、Editダイアログボックスが開き
ます。
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図 5.4　Editダイアログボックス

データ入力フィールドには、フォーマットに従った数値またはC/C++言語の
式を入力できます(「2.2 データ入力」を参照)。新しい数値または式を入力
したら、[OK]ボタンをクリックするか、ENTERキーを押します。ダイアロ
グボックスが閉じ、新しい値がメモリに書き込まれます。

5.2.3  メモリ範囲の選択

選択する範囲がMemoryウィンドウに表示されている範囲内の場合、範囲の
先頭位置でマウスの左ボタンを押して、そのまま範囲の終了位置までドラッ
グします。選択された範囲は強調表示されます。

選択する範囲がMemoryウィンドウに表示されている範囲を超える、または、
Memoryウィンドウに表示されていない場合、Memoryダイアログボックスに
先頭番地およびバイト数を入力して、選択することができます。

5.3 メモリ内の値の検索
Memoryウィンドウの検索機能を使用して、メモリ内の値を検索できます。
値を検索するには、ポップアップメニューの[Search]メニューオプションを
クリックするか、またはMemoryウィンドウが入力フォーカスを持つときにF3
を押します。

Search Memoryダイアログボックスが開きます。

図 5.5　Search Memoryダイアログボックス
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検索したい範囲の開始アドレスと終了アドレス、および検索するデータ値を
入力します。開始アドレスと終了アドレスはMemoryウィンドウで範囲が選
択されている場合は、自動的に設定されます。また、終了アドレスには、符
号＋を値の前に付けて、サイズとして指定することができます。

検索フォーマットを選択して、[OK]をクリックするか、ENTERキーを押し
ます。ダイアログボックスが閉じ、HDIは該当する範囲から指定したデータ
を検索します。データが検出されると、そのデータがMemoryウィンドウに
強調表示され、データが検出されたアドレスを示すメッセージがステータス
バーに表示されます。データが検出されなかった場合は、Memoryウィンド
ウの表示は変更されず、データが検出されなかったことを示すメッセージが
ステータスバーに表示されます。

5.4 メモリ領域に値を埋める
メモリ埋め込み機能を使用して、指定した範囲のメモリアドレスに値を設定
できます。

5.4.1  範囲を埋める

同じ値で指定した範囲のメモリを埋めるためには、[Memory->Fi ll...]メニュ
ーオプションまたはMemoryウィンドウのポップアップメニューの[Fill ...]メ
ニューオプションを選択し、Fill Memoryダイアログボックスを開きます。

図 5.6　Fill Memoryダイアログボックス

Memoryウィンドウでアドレス範囲を選択してある場合、先頭アドレスおよ
び終了アドレスは、自動的に設定されます。検索フォーマットを選択して、
[OK]をクリックするか、ENTERキーを押します。ダイアログボックスが閉
じ、新規の値がメモリ範囲に書き込まれます。
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5.5 メモリ領域の転送
メモリ転送機能を使用して、メモリ領域を転送できます。メモリ範囲を選択
して(「5.2.3メモリ範囲の選択」を参照)、ポップアップメニューの[Copy]メ
ニューオプションを選択し、Copy Memoryダイアログボックスを開きます。

図 5.7　Copy Memoryダイアログボックス

BeginおよびEndフィールドには、Memoryウィンドウで選択した転送元のそ
れぞれのアドレスが設定されています。Destinationフィールドに転送先の開
始アドレスを入力して、[OK]ボタンをクリックするか、ENTERキーを押す
と、このダイアログボックスが閉じ、指定されたメモリブロックが新しいア
ドレスへコピーされます。

5.6 メモリ領域のテスト

注 このテストは、デバッグプラットフォームに依存します。しかし、どのデバ
ッグプラットフォームでも現在のメモリ内容は上書きされ、ユーザプログラ
ムとデータは削除されます。

メモリテスト機能を使用して、アドレス空間内でメモリ領域をテストできま
す。メモリ範囲を選択して(「5.2.3 メモリ範囲の選択」を参照)、ポップア
ップメニューの[Test]メニューオプションを選択します。Test Memoryダイア
ログボックスが開きます。
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図 5.8　Test Memoryダイアログボックス

Beginおよび Endフィールドには、Memoryウィンドウで選択した開始アドレ
スと終了アドレスが設定されています。[OK]ボタンをクリックするか、
ENTERキーを押すと、このダイアログボックスが閉じ、HDIはメモリ範囲
のテストを実行します。

5.7 メモリ領域の保存
メモリ保存機能を使用して、アドレス空間内のメモリ領域をディスクファイ

ルに保存できます。[Memory->Save...]メニューオプションを選択して、Save
Memoryダイアログボックスを開きます。

図 5.9　Save Memoryダイアログボックス

保存したいメモリブロックの開始アドレスと終了アドレス、およびファイル
名を入力します。ファイル名のドロップダウンリストは、以前にセーブした
ファイル名を4つ持っています。また、[Browse...]ボタンを押すと、標準のFile
Save Asダイアログボックスが開きます。[Save]ボタンをクリックするか、
ENTERキーを押すと、このダイアログボックスが閉じ、指定したメモリブ
ロックがS-Recordフォーマットファイルとしてディスクに保存されます。フ
ァイルの保存が完了すると、確認のメッセージボックスが開きます。
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5.8 メモリ領域のロード
メモリ領域のロード機能を使用して、現在のデバッグ情報を削除せずにメモ
リ領域へS-Recordファイルをロードすることができます。[Memory->Load...]
メニューオプションを選択するとLoad Memoryダイアログボックスが開きま
す。

図 5.10　Load Memoryダイアログボックス

Offsetフィールドに値(正または負)を入力して、S-Recordで指定されたアドレ
スから指定した値の分はなれた位置をロードアドレスとすることができま
す。[Open]ボタンをクリックするか、ENTERキーを押すと、このダイアロ
グボックスが閉じ、データがメモリにロードされます。データのロードが完
了すると、確認のメッセージボックスが開きます。

ファイルからのメモリ領域のロードが完了するとSystem Statusウィンドウの
メモリシートに表示します。

5.9 メモリ領域のベリファイ
メモリ比較機能を使用して、現在のメモリブロックと以前に保存したメモリ
ブロックを比較することができます。[Memory->V erify...]メニューオプショ
ンを選択するとVerify S-Record File with Memoryダイアログボックスが開き
ます。

図 5.11　Verify S-Record File with Memoryダイアログボックス

Offsetフィールドに値(正または負)を入力して、S-Recordで指定されたアドレ
スから指定した値の分はなれた位置からベリファイを開始することができま
す。[Open]ボタンをクリックするか、ENTERキーを押すと、このダイアロ
グボックスが閉じ、ファイルとメモリの内容がベリファイされます。ベリフ
ァイが完了すると、確認のメッセージボックスが開きます。
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6 プログラムの実行プログラムの実行プログラムの実行プログラムの実行
本章では、ユーザプログラムの実行方法について説明します。ここでは、命
令を連続実行する方法と、単一命令または複数命令をステップ実行する方法
について述べます。

6.1 リセットからの実行
ユーザシステムをリセットして、リセットベクタアドレスからアプリケーシ
ョンを実行するには、ツールバーのReset Goボタン[ ]をクリックするか、
[Run-> Reset Go]メニューオプションを選択します。

プログラムは、ブレークポイントに到達するかブレーク条件が成立するまで
実行されます。ツールバーのHaltボタン[ ]をクリックするか、[Run->Halt]
メニューオプションを選択して、プログラムを任意のタイミングで停止でき
ます。

注 プログラムは、リセットベクタ位置に格納されたアドレスから実行を開始し
ます。したがって、この位置に開始コードのアドレスが格納されているかど
うかを確認してください。

6.2 連続実行
プログラムが停止し、デバッガがブレークモードになると、HDIは、Source
ウィンドウまたはDisassemblyウィンドウ内で、CPUのプログラムカウンタ
(PC)が示す現在のアドレス値に対応する行を強調表示します。これは、ステ
ップ実行または連続実行の場合に、次に実行される命令となります。

図 6.1　PCが示すアドレス値に対応する行の強調表示

現在のPCのアドレスから連続実行するには、Continueボタン[ ]をクリック
するか、[Run->Go]メニューオプションを選択します。

現在の現在の現在の現在の PCPCPCPC
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6.3 カーソル位置まで実行
プログラムの一部分のみを実行する機能として、特定アドレスまで実行する
Go To Cursor機能があります。

Ü Go To Cursorの使用手順
1. プログラムを停止させたいアドレスが、Sourceウィンドウまたは

Disassemblyウィンドウに表示されていることを確認してくださ
い。

2. Address列でクリックするか、カーソルキーを使用して、停止させ
たいアドレス上にテキストカーソルを合わせます。

3. ポップアップメニューの [Go To Cursor]メニューオプションを選
択します。

これにより、現在のPC値から、カーソル位置で指定したアドレスに到
達するまでプログラムが実行されます。

注 カーソル位置のアドレスのプログラムを実行しない場合は、プログラムは停
止しません。このようなことが起きた場合、ツールバーのHaltボタン[ ]を
クリックするか、ESCキーを押す、または、[Run->Halt]メニューオプショ
ンを選択して、プログラムを手操作で停止できます。

注 Go To Cursor機能は、テンポラリブレークポイントを使用します。ブレーク
ポイント設定数が上限値の場合には、この機能は使用できません。メニュー
オプションが無効状態になります。

6.4 複数ポイントまで実行
Go To Cursorのような処理を実行したいが、停止アドレスがSourceウィンド
ウの外部にある、または複数のアドレスで停止させたいという場合もありま
す。このような場合には、HDIのテンポラリブレークポイント機能を使用し
ます(「7.5 テンポラリブレークポイント」を参照)。

6.5 シングルステップ
プログラムをデバッグ時に、1行単位または1命令単位に実行して、システム
に対するその命令の効果を検証できる機能です。Sourceウィンドウでは、ス
テップ処理はソースの1行をステップ実行します。Disassemblyウィンドウで
は、ステップ処理はアセンブラの1命令をステップ実行します。命令が別の
関数またはサブルーチンを呼び出す場合は、その関数内の各命令をステップ
実行するか、またはその関数全体を１ステップで実行するかをオプションで
指定します。命令が呼び出しを実行しない場合は、いずれのオプションを指
定していても、デバッガはその命令を実行して、次の命令で停止します。
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6.5.1  関数内の各命令をステップ実行

関数内の各命令のステップ実行を選択すると、関数の呼び出しを実行し、そ
の関数の最初の行または命令で停止します。関数内の各命令をステップ実行
するには、Step Inボタン[ ]をクリックするか、[Run->Step In]メニューオ
プションを選択します。

6.5.2  関数全体を１ステップで実行

関数全体の１ステップ実行を選択すると、デバッガは呼び出しとその関数
(および、その関数が実行するすべての関数呼び出し)を実行し、呼び出し元
関数の次の行または命令で停止します。関数全体を１ステップで実行するに
は、Step Overボタン[ ]をクリックするか、[Run->Step Over]メニューオプ
ションを選択します。

6.6 関数の実行停止
デバッグ時に、関数の実行を開始し、検証したい各命令の実行を完了した後、
その関数の残りの全コードを実行して呼び出し元関数に戻りたい場合があり
ます。あるいは、関数全体の１ステップ実行をするつもりが、誤って関数内
の各命令のステップ実行したために、現在の関数の全コードを実行して呼び
出し元関数に戻りたい場合があります(この場合の方に、より有用です)。こ
のような場合には、Step Out機能を使用します。

現在の関数の残コードを実行して呼び出し元関数に戻るには、Step Outボタ
ン[ ]をクリックするか、[Run->Step Out]  メニューオプションを選択しま
す。

6.7 複数のステップ
1度に複数の命令を実行してから停止させるには、Step Programダイアログボ
ックスを使用します。また、このダイアログボックスには、ステップ実行の
間隔を選択できる自動ステップ機能も備わっています。このダイアログボッ
クスを呼び出すには、[Run-> Step...]メニューオプションを選択します。

Step Programダイアログボックスが表示されます。

図 6.2　Step Programダイアログボックス
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Stepsフィールドにはステップ数を入力します。Step Over Callsチェックボッ
クスにより、関数呼び出し全体を１ステップで実行するかどうかを選択しま
す。自動ステップ機能を使用する場合は、Rateフィールドのリストからステ
ップの速度を選択します。ステップ実行を開始するには、[OK]をクリック
するか、ENTERキーを押します。
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7 プログラムの停止プログラムの停止プログラムの停止プログラムの停止
本章では、プログラムの実行を停止する方法を説明します。停止コマンドを
使用して直接停止させる方法と、コード中の特定の位置にブレークポイント
を設定し、停止させる方法について述べます。

7.1 実行の停止
ツールバーのHaltボタンは、プログラムの実行中は有効状態 [ ](赤色の
STOPマーク)、プログラム停止時は無効状態[ ](グレー表示のSTOPマーク)
となります。プログラムを停止するには、ツールバーのHaltボタンをクリッ
クするか、メニューで [Run->Halt]  を選択します。

プログラムの実行が停止され、メッセージ“Break = User Break”がステータ
スバーに表示されます、また、開いているすべてのウィンドウがHDIによっ
て更新されます。

最後にブレークしたときの要因は、System StatusウィンドウのPlatformシー
トに表示されます。

7.2 標準ブレークポイント(PCブレークポイント)
プログラムのデバッグで、PCが1個所または複数の特定個所に達した時点で
実行を停止させたい場合には、その行または命令にプログラムブレークポイ
ントを設定してプログラムを停止させることができます。以下に、プログラ
ムブレークポイントを簡単に設定・削除する方法を示します。Breakpointsウ
ィンドウで、より複雑なブレークポイント操作を行うこともできます。これ
については後で説明します。

Ü プログラムブレークポイントの設定手順
1. プログラムブレークポイントを設定したい位置のSourceウィンドウ
が開いていることを確認します。

2. プログラムを停止したいアドレスが表示されている行のBP列をダ
ブルクリックするかF9キーを押します。

3. プログラムブレークポイントが設定されたことを示す"Break"とい
う語と灰色の丸（●）が、その列に表示されます。

図 7.1　プログラムブレークポイントの設定

PCPCPCPCの現在位置の現在位置の現在位置の現在位置
((((行が強調表示さ行が強調表示さ行が強調表示さ行が強調表示さ
れていますれていますれていますれています))))

ブレークポイブレークポイブレークポイブレークポイ
ントを設定ントを設定ントを設定ントを設定
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これにより、プログラムがプログラムブレークポイントを設定したアドレス
に到達すると、実行が停止して、メッセージ“Break = PC Break”がステー
タスバーに表示されます。また、 Sourceウィンドウの表示が更新されてプ
ログラムブレークポイント行が強調表示されます。

注 プログラムがプログラムブレークポイントを設定したアドレスで停止した場
合、プログラムブレークポイントを設定した行または命令は、実行されませ
ん。プログラムはその行または命令の実行が開始される直前に停止します。
プログラムブレークポイントで停止した後にGoまたはStepを選択すると、次
に実行される命令は強調表示された行となります。

7.2.1  標準ブレークポイントのタイプ切り替え

標準ブレークポイントは通常、PCブレークポイントですが、デバッグプラ
ットフォームによっては、それ以外のタイプのブレークポイントを持つもの
があります。プログラム(PC)ブレークポイントが設定されている行のBP列
でマウスの左ボタンをダブルクリックするか、またはその行にカーソルを置
いてF9キーを押すことにより、ブレークポイントのタイプを切り替える事
ができます。利用可能な標準ブレークポイントタイプによって色付きの丸ま
たは略文字が、BP列に表示されます。

7.2.2  標準ブレークポイントの削除

BP列でマウスの右ボタンをクリックすると、現在のプラットフォームで有
効な標準ブレークポイントタイプのリストを表示します。
現在のブレークポイントタイプには、チェックマークがついています。ブレ
ークポイントを削除するには[None]オプションを選択します。

標準ブレークポイントのタイプ切り替えの操作で、現在のプラットフォーム
に有効な標準ブレークポイントタイプに一通り切り替えた後、さらにもう一
度繰り返すとブレークポイントが削除されます。

7.3 Breakpointsウィンドウ
Breakpointsウィンドウを使用すると、複雑なブレークポイントを設定するこ
とができ(デバッグプラットフォームが各ブレークポイントをサポートして
いる場合)、ブレークポイントの設定／削除および有効／無効に関して、さ
らに詳細に制御できるようになります。Breakpointsウィンドウを開くには、
[View->Breakpoints]メニューオプションを選択します。あるいは、ツールバ
ーにBreakpointsボタン[ ]が表示されていれば、このボタンをクリックして
Breakpointsウィンドウを開くこともできます。
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図 7.2　Breakpointsウィンドウ

このウィンドウは、システムに設定されたブレークポイントのリストを表示
します。ブレークポイントリストは、横方向にEnable、File/Line、Symbol、
Address、およびTypeの5列に分かれています。各列の幅を調整するには、ヘ
ッダバーに表示された各列のタイトル間の境界線をドラッグします。カーソ
ルが に変わり、ドラッグした位置にあわせて、リスト領域に縦線が表示
されます。マウスボタンを離した位置の列幅で、表示が新しい列幅に更新さ
れます。

7.3.1  ブレークポイントの追加

Breakpointsウィンドウに新しいブレークポイントを追加するには、ポップア
ップメニューの[Add...]メニューオプションを選択してください。

Breakpoint/Event Propertiesダイアログボックスが開き、ここで設定したいブ
レークポイントの種類とパラメータを選択できます。

注 Breakpoint/Event Propertiesダイアログボックスは、選択したデバッグプラッ
トフォームに固有のものです。このダイアログボックスの表示内容および動
作は、デバッグプラットフォームで使用可能なブレークポイント機能により
異なります。デバッグプラットフォーム固有のブレークポイントについての
詳細は、別冊の『デバッグプラットフォームのマニュアル』を参照してくだ
さい。

7.3.2  ブレークポイントの変更

Breakpointsウィンドウで既存のブレークポイントを変更するには、リスト上
の該当するブレークポイントに対応する行をダブルクリックしてください。
または、クリックしてそのブレークポイントを選択後、ポップアップメニュ
ーの[Edit...]メニューオプションを選択してください｡

Breakpoint/Event Propertiesダイアログボックスが開き、設定を変更したいブ
レークポイントの種類とパラメータを選択できます。

注 Breakpoint/Event Propertiesダイアログボックスは、選択したデバッグプラッ
トフォームに固有のものです。このダイアログボックスの表示内容および動
作は、デバッグプラットフォームで使用可能なブレークポイント機能により
異なります。デバッグプラットフォーム固有のブレークポイントについての
詳細は、別冊の『デバッグプラットフォームのマニュアル』を参照してくだ
さい。

ブレークブレークブレークブレーク
ポイントポイントポイントポイント
が有効が有効が有効が有効

ブレークブレークブレークブレーク
ポイントポイントポイントポイント
が無効が無効が無効が無効

ヘッダバーヘッダバーヘッダバーヘッダバー
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7.3.3  ブレークポイントの削除

Breakpointsウィンドウから既存のブレークポイントを削除するには、リスト
上の該当するブレークポイントに対応する行をクリックしてブレークポイン
トを選択します。次に、ポップアップメニューの[Delete]メニューオプショ
ンを選択してください。

選択したブレークポイントが削除され、ウィンドウが更新されます。

7.3.4  全ブレークポイントの削除

Breakpointsウィンドウにリストされたブレークポイントをすべて削除するに
は、ポップアップメニューの[Delete All]メニューオプションを選択してくだ
さい。

すべてのブレークポイントが削除され、ウィンドウが更新されます。

7.4 ブレークポイントを無効にする
ある領域のプログラムをデバッグ後、別の領域のプログラムをデバッグし
て、また前の領域に戻りたいという場合に、ある領域にブレークポイントを
設定してデバッグし、別の領域をデバッグするために設定したすべてのブレ
ークポイントを削除し、別の領域のデバッグ後、再び削除したブレークポイ
ントを設定しなければならないのでは、効率が悪くなります。HDIでは、ブ
レークポイントリストにブレークポイントを残したまま、それらを無効にす
ることが可能です。

7.4.1  ブレークポイントを無効にする

各ブレークポイントを無効にするには、リスト上の該当するブレークポイン
トに対応する行をクリックしてそのブレークポイントを選択します。次に、
ポップアップメニューの[Disable]メニューオプションを選択してください。

メニューが閉じ、ブレークポイントリストが更新され、Enable列のチェック
マークが消去され、ブレークポイントが無効になったことが示されます。

7.4.2  ブレークポイントを有効にする

Breakpointsウィンドウでブレークポイントを再度有効にするには、上述のよ
うに、リスト上の該当するブレークポイントに対応する行をクリックしてそ
のブレークポイントを選択します。次に、ポップアップメニューの[Enable]
メニューオプションを選択してください。

メニューが閉じ、ブレークポイントリストが更新され、Enable列にチェック
マークが付き、選択したブレークポイントが再度有効になったことが示され
ます。
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7.5 テンポラリブレークポイント
プログラムの実行を開始して、1つまたは複数のアドレスに達した場合にプ
ログラムを停止したいが、それらのアドレスに恒久的なブレークポイントを
設定したくないという場合があります。たとえば、Go To Cursorと同じよう
な処理を実行したいが、停止アドレスが Sourceウィンドウの外部にある、
または複数のアドレスで停止させたいという場合などが当てはまります。こ
のような場合には、HDIのテンポラリブレークポイント機能を使用して、最
大10箇所のテンポラリブレークポイントを設定して実行します。それらのブ
レークポイントは、プログラムが停止すると削除されます。テンポラリブレ
ークポイントは、Run Programダイアログボックスで設定します。このダイ
アログボックスを開くには、[Run-> Run...]メニューオプションを選択しま
す。

Run Programダイアログボックスが開きます。

図 7.3　Run Programダイアログボックス

Stop Atフィールドに、プログラムを停止する各ポイント(最大10まで)を表す
シンボルまたはアドレスを入力します。 ただし、多重定義関数あるいはク
ラス名を入力した場合、Select Functionダイアログボックスが開くので、設
定する関数を選択してください。詳細については、「10 関数の設定」を参
照してください。

Program Counterフィールドに表示されている、現在のPCアドレスから実行
を開始するには、[Go PC]ボタンをクリックします。CPUをリセットして、
リセットベクタアドレスから実行を開始するには、[Reset Go]ボタンをクリ
ックします。

テンポラリブレークポイントでプログラムが停止すると、テンポラリブレー
クポイントがブレークポイントリストブレークポイントリストブレークポイントリストブレークポイントリストから削除されます。Run Programダイ
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アログボックスを再度選択すると、Stop Atフィールドにテンポラリブレー
クポイントがリストされ、 [Go PC]ボタンまたは[Reset Go]ボタンをクリッ
クすると、再度設定されます。

7.6 ハードウェアブレークポイント(イベント)
注 ハードウェアブレークポイントは、選択したデバッグプラットフォームに固

有のものです。各ブレークポイントの動作は、デバッグプラットフォームで
使用可能なブレークポイント機能により異なります。デバッグプラットフォ
ーム固有のブレークポイントについての詳細は、別冊の『デバッグプラット
フォームのマニュアル』を参照してください。
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8 変数の表示変数の表示変数の表示変数の表示
本章では、プログラムが使用する変数およびデータオブジェクトを見る方法
について説明します。ここでは、変数の表示方法、ウォッチ項目の設定方法、
およびCPUの汎用レジスタ、FPUレジスタ、DSPレジスタおよび内蔵周辺レ
ジスタを見る方法について述べます。

8.1 ツールチップウォッチ
Tooltip Watch機能を使用してプログラム内の変数を迅速に見ることができま
す。

Ü Tooltip Watchの使用手順
1. Sourceウィンドウを開き、ウォッチしたい変数が表示された状態に
します。

2. ウォッチしたい変数の変数名の上にマウスカーソルを移動して静止
します。

図 8.1　Tooltip Watch

8.2 インスタントウォッチ
Instant Watch機能を使用して変数の詳細を見ることができます。

Ü Instant Watchの使用手順
1. Sourceウィンドウを開き、ウォッチしたい変数が表示された状態に
します。

2. 該当する変数をクリックして、変数上にカーソルを移動します。
3. ポップアップメニューの[Instant Watch]メニューオプションを選択
します。

Instant Watchダイアログボックスが開きます。
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図 8.2　Instant Watchダイアログボックス

この変数をWatchウィンドウのウォッチ項目リストに追加するには、[Add
Watch]ボタンをクリックします。

8.3 ウォッチ項目の使用
プログラムを実行しながら、変数の値の変化を確認するには、Watchウィン
ドウを使用します。Watchウィンドウを開くには、[View->Watch]メニュー
オプションを選択するか、ツールバーのWatchボタン[ ]をクリックします。
Watchウィンドウは、最初は空白です。

8.3.1  ウォッチ項目の追加

Watchウィンドウにウォッチ項目を追加する方法は2つあります。一方は、
Sourceウィンドウからアクセスする簡易方式で、もう一方は、Watchウィン
ドウのAdd Watchダイアログボックスを使用する詳細方式です。

簡易方式
変数をWatchウィンドウに簡単に追加するには、Add Watch機能を使用しま
す。

Ü SourceウィンドウでのAdd Watchの使用手順
1. Sourceウィンドウを開き、ウォッチしたい変数が表示された状態に
します。

2. 該当する変数をクリックして、変数上にカーソルを移動します。
3. ポップアップメニューの[Add Watch...]メニューオプションを選択し
ます。

指定した変数がウォッチ項目として追加され、Watchウィンドウが更新
されます。
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詳細方式
詳細方式では、配列やポインタなどの複雑な表現を使用することができま
す。

Ü WatchウィンドウでのAdd Watchの使用手順
1. Watchウィンドウを開きます。
2. ポップアップメニューの[Add Watch...]メニューオプションを選択し
ます。

Add Watchダイアログボックスが開きます。

図 8.3　Add Watchダイアログボックス

ウォッチしたい変数名を入力して、[OK]をクリックします。指定した変数
がWatchウィンドウに追加されます。

図 8.4　Watchウィンドウ

注 追加した変数が、現在の有効範囲外のローカル変数である場合、HDIはその
変数をWatchウィンドウに追加しますが、その変数の値は空白になるか”？”
を表示します。

8.3.2  ウォッチ項目の拡張

ウォッチ項目がポインタ、配列、または構造体の場合は、その項目名の左側
にプラス記号(+)の拡張インジケータが表示されます。これは、そのウォッ
チ項目を拡張できることを表しています。ウォッチ項目を拡張するには、そ
の項目をダブルクリックします。その項目が拡張され、各構成要素(構造体
または配列の場合)またはデータ値(ポインタの場合)が、タブ1つ分インデン
トされて表示されます。プラス記号はマイナス記号(-)に変わります。ウォッ
チ項目の構成要素にもポインタ、構造体、または配列が含まれている場合は、
それらの構成要素の横にもまた、拡張インジケータが表示されます。
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図 8.5　ウォッチ項目の拡張

拡張されたウォッチ項目を圧縮するには、その項目を再度ダブルクリックし
ます。項目の構成要素が圧縮され、1つの項目に戻ります。マイナス記号は
再度プラス記号に変わります。

8.3.3  ウォッチ項目の表示基数の変更

ウォッチ項目の表示基数を変更するには、該当する項目をクリックして、変
更する項目を選択します。ポップアップメニューの[Radix]メニューオプシ
ョンを選択するとサブメニューに基数のリストが表示されます。表示したい
基数を選択しクリックすると、選択した項目の表示基数が変更されます。（メ
インメニューの[Setup->Radix]メニューオプションでは変更できません。）

8.3.4  ウォッチ項目の値の変更

ウォッチ対象の変数の値を変更したい場合があります。たとえば、テストを
実行したい場合や、プログラムにバグがあるため値が正しくない場合などで
す。ウォッチ項目の値を変更するには、Edit Value機能を使用します。

Ü ウォッチ項目の値の変更手順
1.1.1.1.    該当する項目をクリックします。クリックした項目上でカーソルが
点滅します。

2. ポップアップメニューの[Edit Value]メニューオプションを選択しま
す。

Edit Valueダイアログボックスが開きます。

図 8.6　Edit Valueダイアログボックス

New Valueフィールドに新しい値または式を入力して、[OK]をクリックしま
す。Watchウィンドウが更新され、新しい値が表示されます。

拡張表示され拡張表示され拡張表示され拡張表示され
たたたたウォッチウォッチウォッチウォッチ項目項目項目項目

収縮表示された収縮表示された収縮表示された収縮表示された
ウォッチウォッチウォッチウォッチ項目項目項目項目

拡張インジケータ拡張インジケータ拡張インジケータ拡張インジケータ
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8.3.5  ウォッチ項目の削除

ウォッチ項目を削除するには、該当する項目をクリックして、削除する項目
を選択し、ポップアップメニューの[Delete Watch]メニューオプションを選
択します。選択した項目が削除され、Watchウィンドウが更新されます。

注 Watchウィンドウで設定したウォッチ項目をセッションファイルに保存でき
ます。詳細については、「11 ユーザインタフェースの構成」を参照してく
ださい。

8.4 ローカル変数の表示
ローカル変数を見るには、[View->L ocals]メニューオプションを選択して、
Localsウィンドウを開きます。

Localsウィンドウが開きます。

図 8.7　Localsウィンドウ

プログラムをデバッグする際には、実行開始後のステップまたはブレークに
従って、Localsウィンドウが更新され、現在のローカル変数およびそれらの
値が表示されます。定義時に初期設定されていないローカル変数の場合は、
値が代入されるまで、Localsウィンドウ内の値は不定値を表示します。

ローカル変数の表示基数および値の変更は、Watchウィンドウと同様に行え
ます。
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8.5 レジスタの表示
アセンブラ表示または混合表示のSourceウィンドウを使用して、アセンブラ
レベルでデバッグする場合は、汎用レジスタの内容を確認できると便利で
す。これを行うには、Registersウィンドウを使用します。

図 8.8　Registersウィンドウ

Registersウィンドウを開くには、[View->Registers]メニューオプションを選
択するか、ツールバーのRegistersボタン[ ]をクリックします。Registersウ
ィンドウが開き、汎用レジスタの値(16進数表記)がすべて表示されます。

8.5.1  ビットレジスタの拡張

コントロールレジスタやステータスレジスタのようにビット単位で使用され
るレジスタの場合、レジスタ名の左側に拡張インジケータ(+)が付いていま
す。これは拡張表示できることを意味します。(+)記号をダブルクリックす
るとそのレジスタが拡張表示され、拡張インジケータが(+)から(-)に変わり
ます。
拡張表示されたレジスタがレジスタマスクのように、さらにサブグループを
持つ場合は、それらの左側にも拡張インジケータ(+)が付きます。
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図 8.9　ビットレジスタの拡張

拡張表示を解除するには拡張インジケータ(-)記号をダブルクリックします。
拡張表示を解除すると、拡張インジケータは(-)から(+)に戻ります。

8.5.2  レジスタ内容の変更

レジスタの内容を変更する方法は2つあります。一方は簡易変更方式で、ウ
ィンドウに直接入力することで値を入力できます。ただし、この方式は16進
数値のみに限定されます。もう一方は詳細変更方式で、ダイアログボックス
を使用して値を入力する必要がありますが、この方式を使用すると、複雑な
式も入力できます。

簡易変更方式
レジスタの内容を簡単に変更するには、該当する桁をクリックするか、また
は、クリック・ドラッグにより変更したい桁を選択し、反転表示させます。
その桁に新しい値を入力してください。値は、0-9およびa-fの範囲内でなけ
ればなりません。新しい値がその桁に書き込まれ、カーソルがレジスタ内の
次の桁へ移動します。レジスタの最下位桁に値を入力すると、カーソルは、
次のレジスタの最上位桁へ移動します。表示されているレジスタの桁が、た
とえば、CPUの条件コードレジスタ(CCR)などのビットを示している場合
は、SPACEキーを押して、そのビットの値を切り替えることができます。

通常のレジスタ通常のレジスタ通常のレジスタ通常のレジスタ

拡張インジケータ拡張インジケータ拡張インジケータ拡張インジケータ

拡張表示された拡張表示された拡張表示された拡張表示された
ビットレジスタビットレジスタビットレジスタビットレジスタ
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詳細変更方式
レジスタの内容を詳細変更方式で変更する場合は、Registerダイアログボッ
クスを使用します。以下の操作のいずれかを行なって、 Registerダイアログ
ボックスを開いてください。
l 変更したいレジスタをダブルクリックする。
l 変更したいレジスタを選択し、ENTERキーを押す。
l 変更したいレジスタを選択し、ポップアップメニューの[Edit...]メニュ
ーオプションを選択する。

図 8.10　Registerダイアログボックス

HDIの他のデータ入力フィールドと同様に、フォーマットに従った数値また
はC/C++言語の式を入力できます(「2.2 データ入力」を参照)。

ドロップダウンリスト(このリストの内容はCPUモデルおよび選択されたレ
ジスタに依存します)からオプションを選択することにより、レジスタのど
の部分の値を変更するのか（High Word、Low Wordなど）や、値の指定方法
（マスク形式、浮動小数点数など）、あるいはどのフラグビットを修正する
のかを指定することができます。

新しい数値または式を入力し、[OK]ボタンをクリックするか、ENTERキー
を押します。ダイアログボックスが閉じ、新しい値がレジスタに書き込まれ
ます。

8.5.3  レジスタ内容の使用

値を入力する際に、CPUレジスタに設定された値を使用できると便利な場合
があります。たとえば、SourceウィンドウまたはMemoryウィンドウで特定
アドレスを表示する場合などです。これを行うには、先頭に“#”文字を付け
て、レジスタ名を指定します(例：#R1、#PC、#R6L、#ER3など)。

8.6 I/Oレジスタの表示
CPUやROM/RAMに加えて、マイクロコンピュータには内蔵周辺モジュール
も組み込まれています。周辺モジュールの数およびタイプはデバイスによっ
て異なりますが、一般的なモジュールは、DMAコントローラ、シリアルイ
ンタフェース、A/Dコンバータ、統合タイマユニット、バスステートコント
ローラ、およびウォッチドッグタイマです。これらの内蔵周辺モジュールを
プログラムで制御するには、マイクロコンピュータのアドレス空間へマップ
されたレジスタへアクセスします。
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通常、これらの内蔵周辺レジスタの設定および使用は、埋込み型のマイクロ
コンピュータアプリケーションには非常に重要なため、これらのレジスタの
内容を明確に見ることができると便利です。Memoryウィンドウでは、バイ
ト、ワード、ロングワード、単精度浮動小数点、倍精度浮動小数点、または
ASCIIの各値でしかメモリ内のデータを見ることができないため、HDIには、
これらのレジスタを簡単に検証および設定できるI/O Registersウィンドウも
備わっています。

8.6.1  I/O Registersウィンドウのオープン

I/O Registersウィンドウを開くには、[View->I /O Area]メニューオプションを
選択します。あるいは、ツールバーの I/O Registersボタン[ ]をクリックし
て開くこともできます。I/Oレジスタ情報は、内蔵周辺モジュールに対応し
て、モジュールごとに並べて表示されます。I/O Registersウィンドウを初め
て開いた場合には、モジュール名のリストしか表示されません。

図 8.11　I/O Registersウィンドウ

8.6.2  I/Oレジスタ表示の拡張

I/Oレジスタの名前、アドレス、および値を表示するには、そのモジュール
名をダブルクリックするか、あるいはモジュール名を選択し、ENTERキー
を押します。モジュール表示が拡張され、モジュール内の各レジスタの名前、
アドレス、および値が表示されます。そのモジュール名を再度ダブルクリッ
クする(またはENTERキーを押す)と、I/Oレジスタの表示が閉じます。また、
同様の操作で、I/Oレジスタを拡張してビット単位に表示することができま
す。

レジスタのレジスタのレジスタのレジスタの
アドレスアドレスアドレスアドレス

レジスタ名レジスタ名レジスタ名レジスタ名

レジスタの値レジスタの値レジスタの値レジスタの値

I/OI/OI/OI/O レジスタレジスタレジスタレジスタ

モジュール名モジュール名モジュール名モジュール名

ビット情報ビット情報ビット情報ビット情報

無効モジュール無効モジュール無効モジュール無効モジュール
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各ビットの状態は以下のように色分けして表示します。
黒 通常の状態
赤 最後に更新された
グレー 無効になった（周辺機器のコントロールレジスタによ

って）

8.6.3  I/Oレジスタの変更

I/Oレジスタの値を変更する場合、16進数で値を直接入力する事ができます。
また、16進数以外で入力したい場合は、該当するレジスタをダブルクリック
するか、ENTERキーを押して、レジスタの内容を変更するダイアログボッ
クスを開きます。

図 8.12　I/Oレジスタ値変更ダイアログボックス

新しい数値または式を入力後、[OK]ボタンをクリックするか、ENTERキー
を押します。ダイアログボックスが閉じ、新しい値がレジスタに書き込まれ
ます。

注 エミュレータデバッグプラットフォームを使用する場合は、そのデバッグプ
ラットフォームがI/Oレジスタからデータを読み取ることにより、ユーザプ
ログラムの動作に影響がでる可能性があります。たとえば、データレジスタ
の読み取りにより、待ち状態の割り込みをキャンセルする可能性がありま
す。データは、I/O Registersウィンドウで展開したI/Oモジュールからしか読
みとられません(これによりレジスタの各値を表示されます)。つまり、I/Oモ
ジュールを表示する必要がなければ、それらのI/Oモジュールを閉じている
限り、問題は起こりません。プログラムに影響を与えるかどうかをチェック
するには、I/O Registersウィンドウなしでプログラムを実行してください。
また、I/O領域でMemoryウィンドウ(またはDisassemblyウィンドウ)を開いて
いると、同じ影響がでる可能性があることに注意してください。
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9 オーバーレイ機能オーバーレイ機能オーバーレイ機能オーバーレイ機能
本章では、オーバーレイを実現するための設定方法について説明します。

9.1 セクショングループの表示
オーバーレイ機能を利用した場合、つまり同一アドレスに複数のセクション
グループを割り当てた場合、Overlayダイアログボックスにそのアドレス範
囲とセクショングループを表示します。

Overlayダイアログボックスを開くには、[Setup->Overlay]メニューオプショ
ンを選択します。

図 9.1　Overlayダイアログボックス（表示時）

このダイアログボックスには、Addressリストボックスと Section Nameリス
トボックスがあります。Addressリストボックスには、オーバーレイ指定さ
れているアドレス範囲を表示します。
Addressリストボックスの中から、アドレス範囲を選択しクリックします。

図 9.2　Overlayダイアログボックス（アドレス範囲選択時）

Section Nameリストボックスに、選択したアドレス範囲に割り付けられた複
数のセクショングループを表示します。
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9.2 セクショングループの設定
オーバーレイの指定をした場合、Overlayダイアログボックスにより、優先
するセクショングループを設定する必要があります。設定しないで実行する
と不正な動作をします。

まず、Addressリストボックスに表示されたアドレスをクリックします。す
ると、そのアドレスに割り付けられた複数のセクショングループが Section
Nameリストボックスに表示されます。

表示された複数のセクショングループの中から、優先するセクショングルー
プを選択しクリックします。

図 9.3　Overlayダイアログボックス（優先セクショングループ選択時）

セクショングループを選択後、[OK]ボタンをクリックすることにより、優
先するセクショングループを設定しダイアログボックスを閉じます。

[Cancel]ボタンをクリックすると、セクションを設定しないでダイアログボ
ックスを閉じます。

注　オーバーレイ指定のアドレス範囲では、Overlayダイアログボックスで指定
したセクションのデバッグ情報を使用します。そのため、現在ロードしてい
るプログラムのセクションと同一のセクションをOverlayダイアログボック
スで設定してください。
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10 関数の設定関数の設定関数の設定関数の設定
本章では、C++プログラムの多重定義関数およびメンバ関数の設定方法につ
いて説明します。

10.1 関数の表示
多重定義関数およびメンバ関数は、Select Functionダイアログボックスで表
示します。

次のような時、関数名による設定が可能です。

･ ブレークポイントの設定
･ Run Programダイアログボックスでの関数設定
･ Sourceウィンドウ表示時に開く Set Addressダイアログボックスによる
設定

･ Memoryウィンドウ表示時に開く Set Addressダイアログボックスによ
る設定

･ シンボルの追加および変更
･ パフォーマンス・アナリシスの関数設定

上記項目に設定した関数に多重定義関数が存在する場合、あるいはメンバ関
数を含むクラス名を設定した場合、Select Functionダイアログボックスが開
きます。

図 10.1　Select Functionダイアログボックス
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このダイアログボックスは、3つの領域に分割されています。

･ Select Function Nameリストボックス
 多重定義関数あるいはメンバ関数を詳細情報付きで表示します。

･ Set Function Nameリストボックス
 設定する関数を詳細情報付きで表示します。

･ Counterグループエディットボックス
All Function :すべての同一名関数あるいはメンバ関数の個数を

表示します。
Select Function :Select Function Nameリストボックスに表示して

いる関数の個数を表示します。
Set Function: :Set Function Nameリストボックスに表示している

関数の個数を表示します。

10.2 関数の設定
多重定義関数およびメンバ関数は、Select Functionダイアログボックス上で
選択し設定します。選択できる関数は通常1つですが、ブレークポイントを
設定する場合のみ複数選択できます。

10.2.1  関数の選択

関数を選択するには、Select Function Nameリストボックス上で関数を選択後
[＞＞＞＞]ボタンをクリックします。クリックすることによって、選択した関数が
Set Function Nameリストボックス上に表示されます。また、[≫≫≫≫]ボタンをク
リックすることによってSelect Function Nameリストボックス上に表示されて
いるすべての関数を選択することができます。

10.2.2  関数の削除

Set Function Nameリストボックス上に表示されている関数を削除する場合
は、Set Function Nameリストボックス上で関数を選択後 [＜＜＜＜]ボタンをクリッ
クします。また、[≪≪≪≪]ボタンをクリックすることによってSet Function Name
リストボックス上に表示されているすべての関数を削除することができま
す。

10.2.3  関数の設定

Set Function Nameリストボックス上に表示されている関数を設定するには、
[OK]ボタンをクリックします。クリックすることにより、関数を設定し、
ダイアログボックスを閉じます。

[Cancel]ボタンをクリックすると、関数を設定しないでダイアログボックス
を閉じます。
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11 ユーザインタフェースの構成ユーザインタフェースの構成ユーザインタフェースの構成ユーザインタフェースの構成
HDIユーザインタフェースは、頻繁に行う操作にすばやくアクセスできるよ
うに、関連のある操作を論理的な順序でグループ分けをしています。しかし、
デバッグ中には、ユーザインタフェース項目の配置をユーザの使いやすいよ
うに変更したり、ユーザの好みに応じて配置できるように、ユーザインタフ
ェースをカスタマイズできるようになっています。本章では、ユーザインタ
フェースウィンドウの配置を変更、表示形式のカスタマイズ、設定を保存す
る方法について説明します。

11.1 ウィンドウの配置

11.1.1  ウィンドウの最小化

開いたウィンドウを一時的に終了して、現在の状態で再度表示する場合は、
そのウィンドウをアイコン化することができます。つまり、ウィンドウの最
小化ができます。ウィンドウを最小化するには、ウィンドウの最小化ボタン

をクリックするか、ウィンドウメニューで[ -> Minimize]メニューオプシ
ョンを選択します。

図 11.1　ウィンドウの最小化

ウィンドウが最小化され、HDIアプリケーションウィンドウ左下隅にアイコ
ンとして表示されます。上のDisassemblyウィンドウの場合、アイコンは次
のようになります。

図 11.2　Disassemblyウィンドウのアイコン

注 画面の下部に開いているウィンドウがあると、このアイコンが見えない場合
があります。

アイコンをウィンドウに復元するには、アイコンをダブルクリックするか、
ウィンドウメニューの[Restore]を選択します。

最小化ボタ最小化ボタ最小化ボタ最小化ボタンンンン

ウィンドウウィンドウウィンドウウィンドウ
メニューメニューメニューメニュー
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11.1.2  アイコンの整列

アイコンは、デフォルトでHDIアプリケーションウィンドウの左下隅に置か
れます。アイコンは、クリックして新しい位置にドラッグすればアプリケー
ションウィンドウ内の任意の位置に移動させることができます。アイコンを
ウィンドウに復元すると、最小化される前と同じ位置にウィンドウが表示さ
れます。同様に、再び最小化すると、アイコンは最後に移動した位置に表示
されます。

最小化してアイコンとなったウィンドウがいくつもあると、見づらくなりま
す。アイコンを整理するには、[Window->A rrange Icons]メニューオプショ
ンを選択します。

アイコンがアプリケーションウィンドウの左下隅から整列します。

図 11.3　整列前

図 11.4　整列後
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11.1.3  ウィンドウのタイル表示

デバッグ後には、画面上に多くのウィンドウが開いている場合があります。
Tile機能を使用すれば、どのウィンドウも他のウィンドウと重ならないタイ
ルフォーマットで、すべてのウィンドウを配置することができます。これを
行うには、[Window->T ile]メニューオプションを選択します。
現在開いているすべてのウィンドウが、タイルフォーマットで配置されま
す。最小化されアイコンとなっているウィンドウは影響を受けません。

11.1.4  ウィンドウのカスケード表示

ウィンドウを、手前のウィンドウの後ろにウィンドウの左と上の端だけが表
示されるカスケードフォーマットで配置することができます。これを行うに
は、[Window->Cascade]メニューオプションを選択します。現在開いている
すべてのウィンドウが、カスケードフォーマットで配置されます。最小化さ
れアイコンとなっているウィンドウは影響を受けません。

11.2 現在開いているウィンドウの検索
HDIアプリケーションの中に多くのウィンドウが開いていると、他のウィン
ドウの後ろに隠れたウィンドウを見失ってしまうことがあります。見失った
ウィンドウを見つけるには、2つの方法があります。

11.2.1  次のウィンドウの検索

ウィンドウリスト中の次のウィンドウを手前に表示するには、ウィンドウメ
ニューを呼び出し [Next]を選択するか、CTRL+F6を押します。この操作を
繰り返すと、すべてのウィンドウ(開いているものと最小化されているもの)
を順に選択できます。

11.2.2  特定のウィンドウの検索

特定のウィンドウを選択するには、[Window]メニューの一番下にあるウィ
ンドウリスト(開いているものと最小化されているもの)の中で、選択したい
ウィンドウをクリックします。ウィンドウリストでは、現在選択されている
ウィンドウの横にチェックマークが付いています。
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次の例ではDisassemblyウィンドウが、現在選択されているウィンドウです。

図 11.5　ウィンドウの選択

選択したウィンドウが手前に表示されます。上記の例でTraceウィンドウを
選択しています。そのウィンドウが最小化されている場合は、アイコンがウ
ィンドウに復元されます。

11.3 ステータスバーの表示／非表示
HDIアプリケーションウィンドウの下部にステータスバーを表示するかどう
かを選択できます。デフォルトでは表示します。ステータスバーの非表示に
するには、[Setup->Status Bar]メニューオプションを選択します。

ステータスバーが、HDIアプリケーションウィンドウの表示から削除されま
す。ステータスバーを再表示するには、もう一度[Setup->Status Bar]メニュ
ーオプションを選択します。ステータスバーが、HDIアプリケーションウィ
ンドウの表示に追加されます。

11.4 ツールバーのカスタマイズ
ツールバーに表示されるボタンの種類と配列をカスタマイズすることができ
ます。表示を変更するには、[Setup->Customize->Toolbar]メニューオプショ
ンを選択します。

Toolbarダイアログボックスをオープンすると2枚のシートがあります。1枚
目のシートは、ツールバーの表示を設定します。2枚目のシートは、ツール
バーの個々のボタンを設定します。



11章                                           ユーザインタフェースの構成   57

11.4.1  全体概要

Toolbarsシートで、表示するツールバーを選択します。

図 11.6　Customizeダイアログボックス(Toolbarsシート)

ツールバーは、複数選択可能なリストボックスに表示されています。個々の
ツールバーを非表示にする場合は、ツールバー名(ツールバーがメインフレ
ームウィンドウに固定されていない場合に表示されるタイトルバーの名前)
の隣のチェックをクリアします。

注 メニューバーは、チェックをクリアすることはできません。

簡素化されたデスクトップエリアでHDIを使用する場合には’Cool Look’のチ
ェックをはずすとWindows®3.1スタイルのメニュー、ツールバーになりま
す。

ユーザ定義のツールバーを追加することが可能です。[New...]ボタンをクリ
ックし、定義するツールバー名を入力してください。Toolbar Nameエディッ
トボックスで編集することができます。新しいツールバー「My Toolbar」と
して説明します。「My Toolbar」は、メインフレームの左上に現れます。ボ
タンがないのでボタンを追加するには、ツールバーをカスタマイズしなけれ
ばなりません。

11.4.2  ツールバーのカスタマイズ

ユーザ定義のツールバーをカスタマイズするには、マウスまたは、他のポイ
ンティングデバイスが必要になります。キーボードしかない場合は、カスタ
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マイズできません。ツールバーは、マウスのみでしか操作できないため、マ
ウスがない場合にはカスタマイズする必要がないためです。

CustomizeダイアログボックスのCommandsシートでそれぞれのツールバーの
ボタンを設定できます。

図 11.7　Customizeダイアログボックス(Commandsシート)

11.4.3  ボタンカテゴリ

ダイアログボックスの左上部は、ボタンカテゴリのリストです。それぞれの
カテゴリに対応するボタンは右側に表示されます。リスト中のボタンボタン
動作をクリックすると、Descriptionにボタンの動作についての説明が表示さ
れます。

11.4.4  ツールバーへのボタンの追加

Ü ツールバーにボタンを追加する方法を以下に示します。
1. ボタンカテゴリのリストから該当するボタンカテゴリを選択しま
す。

2. 動作リストからボタン項目を選択します。
3. ボタン項目をダイアログからドラッグするとツールバーにボタンが
追加されます。

注 セパレータ(ボタンとボタンの間の空白)はサポートしていません。

ボタン
カテゴリ

使用可能な
ボタン

ボタンの
動作説明
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11.4.5  ツールバーのボタンの位置変更

Ü ツールバーのボタンの位置を変更するには、
1. ツールバー中の移動するボタンを選択します。
2. そのボタンをツールバー内の移動先の位置でドロップします。

注 Ctrlキーを押しながらドロップするとボタンをコピーできます。

11.4.6  ツールバーからのボタンの削除

Ü ツールバーのボタンを削除するには
1. ツールバーから削除するボタンを選択します。
2. 選択したボタンをメインフレーム内のツールバーの外に移動しま
す。

11.5 フォントのカスタマイズ
テキスト形式のウィンドウのフォントをカスタマイズすることができます
（Sourceウィンドウや Memoryウィンドウ）。また、新しいウィンドウをオ
ープンしたときに使われるデフォルトのフォントを設定できます。

フォントを変更するには、[Setup->Customize->Font]メニューオプションを
選択します。Fontダイアログボックスがオープンします。

図 11.8　Fontダイアログボックス

このダイアログボックスは、標準的なWindows®のフォントダイアログボッ
クスと同じ操作ができますが、Fontリストボックスには、固定長幅のフォン
トのみ表示されます。また、[Use as Default Font]ボタンを押すと、新しい
ウィンドウをオープンしたときに使われるフォントを設定することができま
す。
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11.6 ファイルフィルターのカスタマイズ
Browserファイルダイアログでファイルフィルタをカスタマイズできます。
フィルタを変更するには、[Setup->Customize->File Filter]メニューオプショ
ンを選択します。Customize File Filterダイアログボックスがオープンします。

図 11.9　Customize File Filterダイアログボックス

注 このダイアログボックスでの変更は直ちに反映されます。変更を取り消す事
はできません。

フィルターを編集するには、
1. File一覧からファイルグループを選択します。
2. Type一覧から対応するタイプ名を選択します。
3. [Edit...]ボタンをクリックするとEdit Filterダイアログボックスが開き
ます。ダイアログボックスのタイトルには、選択されているファイ
ルグループが表示されます。エディットボックスにはフィルタタイ
プまたは拡張子として指定できる文字以外は入力できません。

4. ファイル拡張子またはフィルタタイプを編集します。同時に2つ以
上の拡張子を指定する場合は、各拡張子をセミコロンで区切ってく
ださい。以下に例を示します。
例
*.mot; *.a20; *.a37

新しいフィルターを入力するには、
1. File一覧からファイルグループを選択します。
2. [Add...]ボタンをクリックするとEdit Filterダイアログボックスが開き
ます。ダイアログボックスのタイトルには、選択されているファイ
ルグループが表示されます。エディットボックスにはフィルタとし
て指定できる文字以外は入力できません。

3. 追加するフィルタタイプと、フィルタに使用したい拡張子を登録し
ます。

注 指定されたフィルタタイプと同じタイプのフィルタが既に存在する場合は、
新しく入力されたフィルタが有効となります。
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フィルタを削除するには、
1. File一覧からファイルグループを選択します。
2. Type一覧から対応するタイプ名を選択します。
3. [Delete]ボタンをクリックすれば、タイプ名を削除します。

11.7 セッションの保存
ユーザプログラムがデバッグプラットフォームにダウンロードされ、対応す
るソースファイルが表示されていて、かつ多くのウィンドウが開いている場
合は、次回このプログラムをロードする時にこうした情報のセットアップに
時間がかかる場合があります。HDIでは、セットアップ時間短縮のために現
在の設定をファイルに保存することができます。
すでに命名されているセッションや、現在のオブジェクトファイルと同名の
セッションを新規に生成をする場合は、[File->Save Session]メニューオプシ
ョンを選択してセッションを更新することができます。

現在の設定を新しい名前で保存するには、[File->Save Session As...]メニュー
オプションを選択します。これにより、ファイル名を要求する標準的なファ
イルダイアログボックスが表示されます。HDIセッションファイル(*.hds)、
ターゲットセッションファイル(*.hdt)とウォッチセッションファイル(*.hdw)
の3つのファイルが保存されます。HDIセッションファイルには、すべての
開いているウィンドウとその位置などのHDIインタフェース設定が含まれま
す。ターゲットセッションファイルには、デバッグプラットフォームの名前
と構成など、デバッグプラットフォーム／ターゲットシステムに固有の設定
が含まれます。ウォッチセッションファイルには、現在のWatchウィンドウ
の変数の情報等を保存します。

これらのファイルが保存されると、HDIタイトルバーの第2エントリとして
セッション名が表示されます。

図 11.10　セッション名の表示

注 セッションファイルにはシンボルやメモリ情報を保存しないため、変更した
情報を再度使用したい場合は別途それぞれのファイルに保存してください。
詳細は、「5.7 メモリ領域の保存」、「13.5.8 Save As …」を参照してくだ
さい。

11.8 セッションのロード
保存したセッションを再ロードするには、[File->Load Session...]メニューオ
プションを選択します。これにより、HDIセッションファイル名(*.hds)を要
求する標準的なWindows®ファイルダイアログボックスが表示されます。
現在開いているウィンドウがあればクローズされ、デバッグプラットフォー
ムへの接続が初期化されます。ユーザプログラムがターゲットにダウンロー
ドされている場合は、ステータスバーが進行状況を表示します。ダウンロー
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ドが完了すると、ウィンドウが開かれ、更新されて、ターゲットからの最新
情報が表示されます。

11.9 HDIオプションの設定
HDIインタフェースを使用するとき、役立つ設定があります。 [Setup-
>Options...]メニューオプションを選択すると、HDI Optionsダイアログボッ
クスが表示されます。

図 11.11　HDI Options（Session）ダイアログボックス

On Exitのラジオボタングループは、プログラム終了時のカレントセッショ
ンの自動保存に使用できます。
l Automatically save session - カレントセッションファイルのセッション情
報を保存します。カレントセッションファイルがない場合は、HDIセッ
ションファイル名を入力するよう求められます。

l Prompt for save session - プログラム終了時に、カレントセッションを保
存したいかどうかを毎回尋ねてきます。Yesを選択すると、カレントセ
ッションファイルにセッション情報が保存されます。カレントセッショ
ンファイルがない場合は、HDIセッションファイル名を入力するよう求
められます。

l Quit without asking - カレントセッション情報を保存するかどうかを尋ね
ず、保存も行わないでプログラムを終了します。

次にプログラムを起動する際、最後に保存したセッションを自動ロードした
い場合は、Load last session on startupチェックボックスをチェックします。
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図 11.12　HDIオプション(Confirmation)ダイアログボックス

Confirmationシートで、確認メッセージボックスの表示／非表示を切り替え
られます。

図 11.13　HDIオプション(Viewing)ダイアログボックス

Tab Sizeリストボックスは、タブを何文字の空白にするかを設定します。指定可能な値
は2から8までです。通常使用しているエディタの空白数に合わせることを推奨します。
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11.10 デフォルト基数の設定
HDIでは、いくつかの基数で数値を表示できます。デフォルトは、16進数で
す。ただし、Countフィールドは、常に10進数です。「2.2.2 データ形式」で
説明した接頭コードのいずれかを使用することができます。使用入力を簡単
にするために、これらのフォーマットのいずれかをデフォルトとして選択す
ることができます。すなわち、その基数を使用する際に対応する接頭コード
を入力する必要がありません。

デフォルトの基数を変更するには、[Setup->Radix]メニューオプションを選
択します。これにより、使用可能な数値表示システムのリストが表示されま
す。現在選択されている基数の左にチェックマークが付いています。

図 11.14　基数の設定
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12 メニューメニューメニューメニュー
このマニュアルでは、標準的なMicrosoft®メニュー命名規約を使用していま
す。

図 12.1  メニュー

チェックマークは、そのメニューオプションにより提供される機能が選択さ
れていることを示します。
省略符号は、そのメニューオプションを選択すると、追加情報の入力が必要
なダイアログボックスが表示されることを示します。

Windows®メニューシステムの使用法については、Windows®ユーザーズマニ
ュアルを参照してください。

12.1 File
Fileメニューは、プログラムファイルにアクセスする場合に使用されます。

12.1.1  New Session...

新しいデバッグプラットフォームを選択ができるようにSession ダイア
ログボックスを表示します。HDIプログラムファイルとして、同じディレク
トリにターゲットDLLが１つしかない場合、このボタンはグレー表示されま
す。HDIがロードされたとき自動的にデバッグプラットフォームが選択され
ます。

12.1.2  Load Session...

セッションファイル(拡張子がhds)を指定してロードできるようにOpen
ダイアログボックスを表示します。セッションファイルには、デバッグプラ
ットフォームの詳細、デバッグプラットフォームの設定、シンボル、ブレー
クポイント、レジスタ値などのウィンドウ情報、位置情報が含まれています。

12.1.3  Save Session

現在のセッションファイルを更新します。現在のセッションファイル
が定義されていない場合は、[Save Session As...]メニューオプションと同様
の動作をします。

12.1.4  Save Session As...

現在のセッションを新しいファイル名でセーブするためにSave Asダイアロ
グボックスを表示します。セッションファイルには、デバッグプラットフォ

メニューメニューメニューメニュー
オプションオプションオプションオプション

メニューバーメニューバーメニューバーメニューバー

メニュータイトルメニュータイトルメニュータイトルメニュータイトル

カスケードメニューカスケードメニューカスケードメニューカスケードメニュー

チェックマークチェックマークチェックマークチェックマーク

省略符号省略符号省略符号省略符号

ドロップダウンドロップダウンドロップダウンドロップダウン
メニューメニューメニューメニュー
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ームの詳細、デバッグプラットフォームの設定、シンボル、ブレークポイン
ト、レジスタ値などウィンドウの情報、位置が含まれています。

12.1.5  Load Program...

Load Programダイアログボックスを表示します。S-Recordフォーマット
(拡張子は*.mot、*.s20、*.obj)またはSYSROFあるいはELF/DWARFフォーマ
ット(拡張子は*.abs)のオブジェクトファイルを選択してデバッグプラットフ
ォームのメモリにダウンロードします。選択したファイルでシンボルが使用
できる場合は、シンボルもロードされます。

12.1.6  Initialize

デバッグシステムを再初期化します。現在オープンしているウィンド
ウをクローズし、デバッグプラットフォームとの接続を解除します。そして、
デバッグプラットフォームの再接続をします。ステータスバーの最左端
に’Link up’と表示されれば、初期化を完了したことを意味します。「12.4.1
Reset CPU」も参照してください。

12.1.7  Exit

HDIを終了します。HDI Optionダイアログボックスの’On Exit’セクションに
指定された動作をします。「12.6.2 Options...」も参照してください。

12.2 Edit
Editメニューは、プログラムのうち、各ウィンドウのデータを変更する場合
や、デバッグプラットフォームのメモリデータに対して、それらのデータを
変更する場合に使用されます。

12.2.1  Cut

内容を変更できるウィンドウでブロックが反転表示されている場合に
のみ使用できます(図では無効状態になっています)。
反転表示されているブロックの内容をウィンドウから削除し、Windows®標
準のクリップボードに格納します。

12.2.2  Copy

内容が変更できるウィンドウでブロックが反転表示されている場合に
のみ使用できます(図では無効状態になっています)。
反転表示されているブロックの内容をWindows®標準のクリップボードにコ
ピーします。

12.2.3  Paste

ウィンドウの内容が変更可能な場合のみ使用できます(図では無効状態
になっています)。
Windows®標準のクリップボードの内容をウィンドウの現在のカーソル位置
にコピーします。

12.2.4  Find

ウィンドウにテキストが含まれている場合のみ使用できます(図では無
効状態になっています)。
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Findダイアログボックスを表示し、ユーザが単語を入力してテキスト中の出
現箇所を検索できるようにします。一致する単語を見つけると、カーソルが
その単語の先頭に移動します。

12.2.5  Evaluate...

Evaluateダイアログボックスを表示します。たとえば"(#pc + 205)*2"の
ような数式を入力して、その結果を現在サポートされているすべての基数で
表示します。

12.3 View
Viewメニューは、新規に各ウィンドウを開くために使用されます。メニュ
ーオプションがグレー表示されていれば、そのウィンドウによって提供され
る機能は現在のデバッグプラットフォームで使用できません。

12.3.1  Breakpoints

Breakpointsウィンドウを開きます。現在設定されているブレークポイ
ントを表示して変更できるようにします。

12.3.2  Command Line

Command Lineウィンドウを開きます。テキストベースのコマンドを使
用して、デバッグプラットフォームを制御できます。これらのコマンドは、
バッチファイルから読み込み、結果をログファイルに書き出すことができま
す。これにより、自動テストが実行できます。

12.3.3  Disassembly...

表示させるテキストファイル名を入力できるようにOpenダイアログボ
ックスを表示します。

12.3.4  I/O Area

I/O Registersウィンドウを開きます。ターゲットの内蔵入出力機能(たと
えば割り込みコントローラ)を制御することができます。

12.3.5  Labels

プログラム中のシンボル・ラベルを操作できるようLabelsウィンドウ
を表示します。

12.3.6  Locals

Localsウィンドウを開きます。現在の関数において定義されている変
数の値を表示し、変更できるようにします。PCが C/C++ソースレベル関数
の中になければ、ウィンドウは空白となります。

12.3.7  Memory...

Open Memory Windowダイアログボックスを表示します。Memoryウィ
ンドウ内に表示するメモリブロック位置と表示フォーマットを指定できるよ
うにします。
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12.3.8  Performance Analysis

Performance Analysisウィンドウを開きます。ユーザプログラムの特定
のセクションが呼び出される回数を計測・表示できるようにします。

12.3.9  Registers

Registersウィンドウを開きます。現在のCPUのすべてのレジスタとそ
の内容を見ることができます。

12.3.10  Source...

Openダイアログボックスを表示します。表示したいソースファイル
（C/C++言語フォーマットまたはアセンブラ言語フォーマット）のファイル
名を入力します。ソースファイルが現在のプログラムに含まれていない場
合、あるいはアブソリュートファイル(*.abs)内にそのファイルのデバッグ情
報がない場合は、"Cannot load program. No Source level debugging available"と
いうメッセージが表示されます。

12.3.11  Status

System Statusウィンドウを開きます。デバッグプラットフォームの現在
の状態、セッション、プログラム名を見られるようにします。

12.3.12  Trace

Traceウィンドウを開きます。現在のトレース情報を見られるようにし
ます。

12.3.13  Watch

Watchウィンドウを開きます。C/C++ソースレベルの変数を入力し、そ
の内容を表示・変更できるようにします。

12.4 Run
Runメニューは、デバッグプラットフォームにおけるユーザプログラムの実
行を制御するために使用されます。

12.4.1  Reset CPU

ターゲットハードウェアをリセットし、PCをリセットベクタアドレス
に設定します(デバッグプラットフォームのリセットについては  12.1.6
Initializeを参照)。

12.4.2  Go

現在のPCからユーザプログラムを実行します。

12.4.3  Reset Go

リセットベクタアドレスからユーザプログラムを実行します。

12.4.4  Go To Cursor

現在のPCからユーザプログラムの実行を開始し、PCが現在のテキスト
カーソル(マウスカーソルではありません)の位置によって示されたアドレス
に到達するまで継続します。
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12.4.5  Set PC To Cursor

PCを現在のテキストカーソル(マウスカーソルではありません)の位置
によって示されるアドレスに設定します。アドレスが有効でなければ、無効
です。

12.4.6  Run...

Run Programダイアログボックスを表示します。ユーザプログラムの実行開
始前にブレークポイントを入力できます。

12.4.7  Step In

ユーザプログラムの1ブロックを実行して停止します。このブロックの
サイズは、通常は単一の命令ですが、ユーザが複数の命令またはC/C++ソー
ス行に設定することも可能です(12.4.10 Step...参照)。サブルーチンを呼び出
した場合は、そのサブルーチンに入って実行を停止し、サブルーチンのコー
ドを表示します。

12.4.8  Step Over

ユーザプログラムの1ブロックを実行して停止します。このブロックの
サイズは、通常は単一の命令ですが、ユーザが複数の命令またはC/C++ソー
ス行に設定することも可能です(12.4.10 Step...参照)。サブルーチンを呼び出
す場合は、そのサブルーチンには入らず、現在のPC位置が現在の表示の次
行に設定されるまでユーザプログラムが実行されます。

12.4.9  Step Out

現在の関数の終わりに到達するまでユーザプログラムを実行し、呼び
出す関数の次の行にPCを設定して停止します。

12.4.10  Step...

Step Programダイアログボックスを表示します。ステップ動作の設定を
変更できるようにします。

12.4.11  Halt

ユーザプログラムの実行を停止します。

12.5 Memory
Memoryメニューは、プログラムがアクセスするメモリの設定に使われます。

12.5.1  Refresh

すべてのオープンしているMemoryウィンドウの内容を強制的にアップデー
トします。

12.5.2  Load...

メモリ領域のアドレスのオフセット、S-recordフォーマットのファイル
を選択できるように、Load Memory Fileダイアログボックスを表示します。

12.5.3  Save...

メモリ領域の開始、終了アドレスを指定し、S-recordフォーマットでフ
ァイルを保存するためのSave Memory Fileダイアログボックスを表示しま
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す。Memoryウィンドウ中の反転表示されたメモリブロックは、ダイアログ
ボックスが表示されたときに自動的に設定される開始、終了アドレスです。

12.5.4  Verify...

ディスク上のS-recordファイルとベリファイするメモリ領域の開始、終
了アドレスを設定するためのVerify S-Record File with Memoryダイアログボ
ックスを表示します。

12.5.5  Test...

Test Memoryダイアログボックスを表示します。メモリブロックを指定
して、デバッグプラットフォームのメモリブロックに対して、読み取り/書
き込み動作が正しく行われているかをテストします。このテストは、ターゲ
ットに依存します。しかし、すべてのケースで現在のメモリ内容は上書きさ
れ、プログラムとデータは削除されます。

12.5.6  Fill...

Fill Memoryダイアログボックスを表示します。デバッグプラットフォ
ームのメモリブロックに値を書き込みます。

12.5.7  Copy...

Copy Memoryダイアログボックスを表示します。デバッグプラットフ
ォームの同一メモリスペース内で、メモリブロックを別の位置にコピーしま
す。これらのブロックは重なってもかまいません。開始、終了フィールドは、
Findオプションと同様に設定されます。

12.5.8  Compare...

メモリ領域の開始アドレスと終了アドレスを指定し、別のメモリ領域
と比較するためのCompare Memoryダイアログボックスを表示します。
Memoryウィンドウ中の反転表示されたメモリブロックは、ダイアログボッ
クスが表示されたときに自動的に設定される開始、終了アドレスです。

12.5.9  Configure Map

Memory Mappingウィンドウを開きます。デバッグプラットフォームの
現在のメモリマップを表示し、(サポートされていれば)変更できるようにし
ます。デバッグプラットフォームにより、Memory Mapダイアログボックス
が開きます。

12.5.10  Configure Overlay...

Overlayダイアログボックスを表示します。オーバーレイ機能を利用し
た場合、優先するセクショングループを設定することができます。
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12.6 Setup
Setupメニューは、HDIユーザインタフェースの設定変更と、デバッグプラ
ットフォームの設定に使用されます。

12.6.1  Status Bar

ステータスバーの表示/非表示を切り換えます。ステータスバーが表示にな
っている場合は、メニューテキストの左にチェックマークが表示されます。

12.6.2  Options...

HDI Optionsダイアログボックスを表示します。HDI固有の設定(デバッ
グプラットフォーム依存の設定ではありません)を変更できるようにしま
す。

12.6.3  Radix

　数値を表示したり入力する場合の、(基数の接頭部を入力し
なかった場合の)基数のデフォルトの設定をカスケードメニューとして表示
します。現在選択されている基数は左にチェックマークが付いていて、ツー
ルバーの対応するボタンが押し下げられています。
たとえば現在の基数がDecimalならば、10進法の10は"10"と表示され、"10"、
"H'A "、"0x0a "などと入力できます。現在の基数がHexadecimalならば、10
進法の10は"0A"と表示され、"A"、"D'10 "などと入力できます。

12.6.4  Customize

ユーザがカスタマイズできるオプションのリストをカスケード
メニューとして表示します。
Toolbar このカスケードメニューオプションを選択するとCustomizeダイア
ログボックスを表示します。
Font このカスケードメニューオプションを選択するとFontダイアログボッ
クスを表示します。固定長ピッチのフォントを選択することができます。
File Filter  このカスケードメニューオプションを選択するとCustomize File
Filterダイアログボックスを表示します。オブジェクト、ソースファイル、
メモリファイルのファイルフィルタを変更できます。

12.6.5  Configure Platform...

set-upダイアログボックスを表示します。新しいデバッグプラットフォ
ームを選択できるようにします。デバッグプラットフォームのユーザーズマ
ニュアルには、ダイアログボックスの指定可能なオプションについてより詳
細に記述してあるので参照してください。
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12.7 Window
Windowメニューは、現在開いている各ウィンドウの表示変更に使用されま
す。以下のメニューオプションは常に表示されています。また、現在開いて
いるウィンドウの番号付きリストも一緒に表示されます。一番手前に表示さ
れているウィンドウにはチェックマークがついています。

12.7.1  Cascade

ウィンドウを標準的なカスケード方式で、すなわち各ウィンドウのタ
イトルバーが見えるように左上から配置します。

12.7.2  Tile

ウィンドウを標準的なタイル方式で表示、すなわちすべてのウィンド
ウが重ならずに表示されるよう各ウィンドウのサイズを変更します。

12.7.3  Arrange Icons

アイコン化されたウィンドウを、親フレームの下辺に沿って標準的な
方式できれいに整列させます。

12.7.4  Close All

すべてのウィンドウをクローズします。

12.8 Help
Helpメニューは、HDIが提供する機能の使用方法に関する追加情報へのアク
セスに使用されます。

12.8.1  Index

メインヘルプファイルのインデックスを開きます。

12.8.2  Using Help

Windows®ハイパーテキストヘルプシステムの使用方法のヘルプファイルを
開きます。

12.8.3  Search for Help on

メインヘルプファイルを開き、Searchダイアログボックスを表示します。こ
のダイアログボックスで、ファイルのキーワードを入力・閲覧することがで
きます。

12.8.4  About HDI

About HDIダイアログボックスを表示します。HDIと現在ロードされている
DLLのバージョンを確認することができます。
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13 ウィンドウウィンドウウィンドウウィンドウ
本章では、各ウィンドウの種類と、それぞれがサポートしている機能、およ
び関連ポップアップメニューにより使用できるオプションについて説明しま
す。

13.1 Breakpoints

図 13.1  Breakpointsウィンドウ

現在設定されているブレークポイントの表示や制御を行い、ハードウェアの
ブレークポイントリソースを表示するウィンドウです。サポートされている
ブレークポイントの種類とリソースについては、別冊の『デバッグプラット
フォームのマニュアル』を参照してください。
ウィンドウ内でマウスの右ボタンをクリックするとポップアップメニューが
表示されます。このメニューには以下のオプションが含まれています。

13.1.1  Add...

Breakpoint/Event Propertiesダイアログボックスを表示して、新しいブレーク
ポイントを入力します。このダイアログボックスは、デバッグプラットフォ
ームに依存します。

13.1.2  Edit...

ブレークポイントが選択されている場合のみ有効です。Breakpoint/Event
Propertiesダイアログボックスを表示して、既存のブレークポイントの設定
を変更できます。このダイアログボックスは、デバッグプラットフォームに
依存します。

13.1.3  Delete

ブレークポイントが選択されている場合のみ有効です。選択されているブレ
ークポイントを削除します。ブレークポイントを削除しないで、詳細情報は
保持したまま、条件が成立した場合に実行を停止させないようにする場合
は、Disableオプションを使用します(13.1.5 Disable/Enable参照)。

13.1.4  Delete All

すべてのブレークポイントをリストから削除します。
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13.1.5  Disable/Enable

ブレークポイントが選択されている場合のみ有効です。選択されているブレ
ークポイントの有効(Enable)/無効(Disable)を切り替えます(無効にした場合
は、ブレークポイントはリストには残りますが、指定した条件が成立しても
実行を停止しません)。ブレークポイントが有効となっていれば、メニュー
テキストの左にチェックマークが付きます(かつ、そのブレークポイントの
Enable列に'x'が表示されます)。

13.1.6  Go To Source

ブレークポイントのあるSourceまたはDisassemblyウィンドウをオープンしま
す。

13.2 Command Line

図 13-2  Command Lineウィンドウ

ウィンドウメニューやウィンドウコマンドを使用しないで、テキストベース
のコマンドを入力してデバッグプラットフォームを制御できるウィンドウで
す。あらかじめ定義した一連のコマンドをバッチファイルから呼び出してデ
バッグプラットフォームに送り、出力結果をログファイルに記録する必要が
ある場合に便利です。使用できるコマンドについては、オンラインヘルプを
参照してください。
ウィンドウタイトルとしてバッチファイル名とログファイル名をコロンで区
切って表示します。

ツールバーボタンの機能は、以下に示すポップアップメニューオプションと
同じです。

13.2.1  Run Batch File

Run Batch Fileダイアログボックスを表示します。HDIコマンドファイ
ル名(*.hdc)を入力できます。コマンドファイルは、自動的に実行します。フ
ァイル名をウィンドウのタイトルバーに表示します。
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13.2.2  Play

最後に実行されたコマンドファイルを実行します。このボタンは、バ
ッチファイルの実行中はグレー表示され、コマンドファイルの実行が停止し
てユーザに制御が戻ったときに有効表示されます。

13.2.3  Set Log File

Open Log Fileダイアログボックスを表示します。出力結果を記録する
HDIログファイル(*.log)の名前を入力します。ロギングオプションは自動的
に設定され、ログファイル名がウィンドウ上に表示されます。
既に存在しているログファイル名を指定すると、ログを追加するか、以前の
ログを消去して、新しいログを上書きするかを尋ねられます。

13.2.4  Logging

ファイルへのロギング処理を実行するか、停止するかを切り替えます。
ロギングが実行状態になっていれば、メニューテキストの左にチェックマー
クが付きます(かつボタンが無効状態になります。)。ログファイルの内容は、
ロギングが終了するか、チェックボックスをクリアしてロギングを一時的に
停止しなければ表示できないことにご注意ください。ロギングを再び開始す
ると、ログファイルに追加されます。

13.3 Disassembly
本ウィンドウは、アセンブラレベルでプログラムを表示します。

アセンブラフォーマットは他の2つとは異なったレイアウトです。列にシン
ボル名を表示することがあります。アセンブラ情報はメモリ内容を逆アセン
ブルします。オブジェクトファイルからデバッグ情報を読まずにメモリ内容
を直接編集、表示します。対応するソースファイルがない場合には、”Code”
とウィンドウタイトルに表示します。

図 13.3  Disassemblyウィンドウ
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各列に対してダブルクリック動作をサポートしています。
・ BP

そのアドレスに対し、標準ブレークポイントを設定または解除します。
・ Address

Set Addressダイアログボックスを表示します。新しいアドレスを入力
できます。そのアドレスが、ソースファイル中にあれば、新しいウィ
ンドウをオープンし、カーソルが該当個所をさします。もしくは、ソ
ースプログラムの該当個所を表示します。アドレスに対応するソース
ファイルがないときには、本ウィンドウがそのアドレスまでスクロー
ルします。アドレスとして多重定義関数名やクラス名を入力すると
Select Functionダイアログボックスがオープンするので、関数を選択し
てください。

・ Code and Assembler
Assemblerダイアログボックスを表示します。任意のアドレスの命令を
変更できます。機械語を変更しても、ソースファイルには反映されま
せん。また、そのセッション終了時に変更した情報が失われるので注
意してください。

・ Label
Labelダイアログボックスを表示します。新しいラベルの入力やラベル
の削除、編集ができます。

・ Source
スタートメニューのHDIショートカットで設定されているエディタが
該当個所を表示します。

BP列で右クリックすると現在サポートされている標準ブレークポイントタ
イプを表示します。現在、選択されているブレークポイントタイプがメニュ
ーの左側にチェックされています。
ウィンドウ内のBP列以外のところで右クリックすると使用可能なオプショ
ンがポップアップメニューで表示されます。

13.3.1  Copy

テキストブロックが反転表示されている場合にのみ使用できます。反
転表示されたテキストをWindows®クリップボードにコピーし、他のアプリ
ケーションに貼り付けられるようにします。

13.3.2  Set Address

Set Addressダイアログボックスを表示します。新しい開始アドレスを入力す
ると、ウィンドウが更新され、ユーザが入力したアドレスが左上端のアドレ
スとなります。アドレスとして多重定義関数あるいはメンバ関数を含むクラ
ス名を入力した場合、Select Functionダイアログボックスが開くので、設定
する関数を選択します。
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13.3.3  Go To Cursor

現在のPCアドレスからプログラムを実行します。プログラムは、PCが
テキストカーソル(マウスカーソルではありません)の位置によって指定され
たアドレスに達するか、別のブレーク条件が成立するまで実行されます。デ
バッグプラットフォームによってサポートされていない場合、このメニュー
オプションはグレー表示されます。

13.3.4  Set PC Here

PCの値をテキストカーソル(マウスカーソルではありません)の位置によって
指定されたアドレスに変更します。

13.3.5  Instant Watch

変数名を現在のテキストカーソル(マウスカーソルではありません)の位置か
ら抜き出して名前とともにInstant Watchダイアログボックスを表示します。
ソース行が有効なときのみ機能します。

13.3.6  Add Watch

テキストカーソル (マウスカーソルではありません)の位置の表示から抽出
した名前を、ウォッチ変数のリストに追加します。Watchウィンドウが開い
ていない場合はこれを開いて、他のウィンドウの一番上に表示されます。ソ
ース行が有効なときのみ機能します。

13.4 I/O Registers

図 13.4　I/O Registersウィンドウ

ユーザハードウェアシステムのオンチップ周辺機器の参照、設定ができま
す。周辺機器はモジュールによって構成されており、表示される周辺機器の
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詳細情報はリスト表示され、’+’記号は変数名をダブルクリックすれば情報
を拡張できることを、’-’記号は情報を圧縮できることを示します。

’+’記号および’-’記号をダブルクリックするか、’+’キーおよび’-’キーを入力
するとレジスタの情報を拡張／収縮表示します。

ウィンドウ内でマウスの右ボタンをクリックするとポップアップメニューが
表示されます。このメニューには以下のオプションが含まれています。

13.4.1  Copy

テキストブロックが反転表示されている場合にのみ使用できます。反
転表示されたテキストをWindows®クリップボードにコピーし、他のアプリ
ケーションに貼り付けられるようにします。

13.4.2  Edit...

選択しているレジスタの値を変更するダイアログボックスを表示します｡

13.4.3  Expand/Collapse

選択しているモジュール情報を拡張、または圧縮します｡

13.5 Labels

図 13.5　Labels ウィンドウ

カラムヘッダをクリックすることで、シンボルをアルファベット順またはア
ドレス順にソートして表示します。
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各列に対してダブルクリック動作をサポートしています。
・ BP

そのアドレスで標準のイベントをトグルします。
・ Address

関数の先頭アドレスでソースファイルをオープンします。
・ Name

Edit Labelsダイアログボックスをオープンします。

右クリックするとBP列に現在サポートされている標準ブレークポイントタ
イプを表示します。現在、選択されているブレークポイントタイプがメニュ
ーの左側にチェックされています。
ウィンドウ内のBP列以外のところで右クリックすると使用可能なオプショ
ンがポップアップメニューで表示されます。

13.5.1  Add...

Add Labelダイアログボックスを表示します。

図 13.6　Add Labelダイアログボックス

新しいラベル名をNameフィールドに入力し、対応する値をValueフィールド
に入力して[OK]を押します。Add Labelダイアログボックスがクローズし、
ラベルリストに新しいラベルが追加され更新されます。多重定義関数やクラ
ス名を入力したときは、Select Functionダイアログボックスがオープンされ
るので、関数を選択してValueフィールドを設定します。詳細は「10 関数の
設定」を参照してください。

13.5.2  Edit...

Edit Labelダイアログボックスが表示されます。

図 13.7　Edit Labelダイアログボックス

ラベル名と対応する値を編集して、[OK]を押すとラベルリストに編集が反
映され保存されます。多重定義関数やクラス名を入力したときは、Select
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Functionダイアログボックスがオープンされるので、関数を選択してValueフ
ィールドを設定します。詳細は「10 関数の設定」を参照してください。

13.5.3  Find...

Find Label Containingダイアログボックスを表示します。

図 13. 8　Find Label Containing ダイアログボックス

検索したいラベル名の一部、全部をエディットボックスに入力し、[OK]ボ
タンまたは、ENTERキーを押すと、ダイアログボックスはクローズし、指
定された文字列を含んでいるテキストファイルをサーチします。

注 ラベルのはじめの1024文字でソートします。したがって、最初の文字は重複
しないようにしてください。ラベルは、大文字、小文字を区別します。

13.5.4  Delete

シンボルリストから選択されたラベルを削除します。Deleteキーでも同様の
動作です。確認メッセージが表示されます。

図 13.9　ラベル削除確認メッセージボックス

Yesボタンをクリックするとラベルリストから削除されウィンドウが更新さ
れます。メッセージボックスの表示不要のときは、HDI Option Dialogの
Confirm Delete Labelオプションを選択しないでください。

13.5.5  Delete All

リストからすべてのラベルを削除します。確認メッセージボックスが表示さ
れます。

図 13.10　Confirming All Label Deletionメッセージボックス
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Yesボタンをクリックすると、すべてのラベルがHDIのシンボルテーブルか
ら削除され、リスト表示もクリアされます。メッセージボックスの表示不要
のときは、HDI Option DialogのConfirm Delete All Labelオプションを選択し
ないでください。

13.5.6  Load...

現在のHDIのシンボルテーブルに結合します。Load Symbolダイアログボッ
クスがオープンされます。

図 13.11　Load Symbols ダイアログボックス

ダイアログボックスは、Windows®標準のopen fileダイアログボックスと同様
です。ファイルを選択し、Openをクリックするとロードを開始します。シ
ンボルファイルの標準拡張子は”.sym”です。シンボルのロードが完了すると
ロードしたシンボル数を表示したメッセージボックスを表示します。

13.5.7  Save

現在のシンボルテーブルをシンボルファイルに保存します。

13.5.8  Save As...

Save SymbolsダイアログボックスはWindows®標準のSave File Asダイアログ
ボックスと同様に操作できます。File nameフィールドにファイル名を入力し
Openをクリックするとシンボルファイルにラベルリストを保存します。標
準ファイル拡張子は”.sym”です。
シンボルファイルフォーマットが付録Fにあるので参照してください。
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13.6 Locals

図 13.12　Localsウィンドウ

すべてのローカル変数を表示・変更できるウィンドウです。このウィンドウ
は、アブソリュートファイル (*.abs)に含まれるデバッグ情報によって、現
在のPC位置から関数内にあるローカル変数に関連づけることができない場
合は空白となります。

変数はリスト表示され、’+’記号は変数名をダブルクリックすれば情報を拡
張表示できることを、’-’記号は情報を収縮表示できることを示します。ま
た、’+’／’-’キーでも拡張／収縮表示することができます。情報の表示につ
いては、「8.3.2 ウｫッチ項目の拡張」を参照してください。

ウィンドウ内でマウスの右ボタンをクリックするとポップアップメニューが
表示されます。このメニューには次のオプションが含まれています。

13.6.1  Copy

テキストブロックが反転表示されている場合にのみ使用できます。反
転表示されたテキストをWindows®クリップボードにコピーし、他のアプリ
ケーションに貼り付けられるようにします。

13.6.2  Edit Value...

選択しているローカル変数の値を変更するダイアログボックスを表示しま
す｡

13.6.3  Radix

選択しているローカル変数の表示基数を変更します。
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13.7 Memory Mapping

図 13.13　Memory Mappingウィンドウ

デバッグプラットフォームのメモリマップを表示・変更して、デバッグプラ
ットフォームのメモリ構成およびリソースを表示するウィンドウです。デバ
ッグプラットフォームによりMemory Mapダイアログボックスとして表示し
ます。また、コマンドボタンの機能は、デバッグプラットフォームにより以
下に示したポップアップメニューオプションと異なる場合があります｡
ウィンドウ内でマウスの右ボタンをクリックするとポップアップメニューが
表示されます。このメニューには次のオプションが含まれています。

13.7.1  Add

Edit Memory Mappingダイアログボックスを表示します。マップに追加する
新規メモリ領域の詳細情報を入力します。デバッグプラットフォームがマッ
プの変更をサポートしていない場合、このメニューオプションはグレー表示
されます。

13.7.2  Edit

Edit Memory Mappingダイアログボックスを表示します。現在選択されてい
るメモリマップの詳細情報を変更します。デバッグプラットフォームがマッ
プの変更をサポートしていない場合、このメニューオプションはグレー表示
されます。

13.7.3  Reset

マップ情報をデバッグプラットフォームのデフォルト値に戻します。デバッ
グプラットフォームがマップの変更をサポートしていない場合、このメニュ
ーオプションはグレー表示されます。

13.7.4  Help

ヘルプを起動します｡
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13.8 Memory

図 13.14　Memoryウィンドウ

デバッグプラットフォームのメモリ内容を表示・変更できるウィンドウで
す。メモリはASCII、バイト、ワード、ロングワード、単精度浮動小数点、
倍精度浮動小数点の各フォーマットで表示できます。タイトルバーは現在の
表示スタイルと、直前のラベル(シンボル)からのオフセットで示したアドレ
スを示します。
メモリ内容は、現在のカーソル位置で入力するか、データ項目をダブルクリ
ックして変更することができます。データ項目をダブルクリックするとEdit
ダイアログボックスが表示され、複雑な式を使用して新しい値を入力できま
す。そのアドレスのデータが変更できない(すなわちROMまたは未使用領域
上にある)場合は、"Invalid address value"というメッセージが表示されます。
Address列でダブルクリックするとSet Addressダイアログボックスが表示さ
れて、新しい開始アドレスを入力できるようになります。[OK]をクリック
するとウィンドウが更新されて、入力したアドレスが、１行目になるように
表示されます。

ウィンドウ内でマウスの右ボタンをクリックするとポップアップメニューが
表示されます。このメニューには以下のオプションが含まれています。

13.8.1  Set Address...

Set Addressダイアログボックスを表示します。新しい開始アドレスを入力す
ると、ウィンドウが更新され、ユーザが入力したアドレスが左上端のアドレ
スとなります。アドレスとして多重定義関数あるいはメンバ関数を含むクラ
ス名を入力した場合、Select Functionダイアログボックスが開くので、設定
する関数を選択します。

13.8.2  Load...

Load Memoryダイアログボックスを表示します。現在のデバッグ情報を削除
せずにデバッグプラットフォームのメモリにS-recordファイル(*.mot)をロー
ドします。offsetフィールドは、アドレス値を変更するときに指定します。
オプショナルベリファイフラグはダウンロードが正常に行われたかどうかを
チェックします。
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13.8.3  Save...

Save Memory Asダイアログボックスを表示します。デバッグプラットフォー
ムのブロックをS-recordファイル(*.mot)でセーブします。開始フィールドと
終了フィールドは、Findオプションと同様に設定されます。

13.8.4  Test...

Test Memoryダイアログボックスを表示します。デバッグプラットフォーム
内のメモリブロックを検査します。テストの詳細は、デバッグプラットフォ
ームに依存します。開始フィールドと終了フィールドは、Findオプションと
同様に設定されます。

13.8.5  Fill...

Fill Memoryダイアログボックスを表示します。デバッグプラットフォーム
のメモリブロックに指定した値を書き込みます。開始フィールドと終了フィ
ールドは、Findオプションと同様に設定されます。

13.8.6  Copy...

Move Memoryダイアログボックスを表示します。デバッグプラットフォー
ムのメモリブロックを同一メモリ空間内の別の場所にコピーします。ブロッ
クはオーバラップしても構いません。開始フィールドと終了フィールドは、
Findオプションと同様に設定されます。

13.8.7  Compare...

Compare Memoryダイアログボックスを表示します。メモリ領域の開始アド
レスと終了アドレスを選択して別のメモリ領域と比較します。Memoryウィ
ンドウでメモリブロックが反転表示されていれば、ダイアログボックスが表
示されたときに開始アドレスと終了アドレスが自動的に入力されます。
メモリベリファイに似ていますが、本機能は、2つのメモリブロックを比較
します。

13.8.8  Search...

Search Memoryダイアログボックスを表示します。デバッグプラットフォー
ムのメモリブロックの中で指定したデータ値を検索します。メモリブロック
が反転表示されている場合は、ダイアログボックスの開始フィールドと終了
フィールドに、反転表示されているブロックに対応する開始アドレスと終了
アドレスが自動入力されます。

13.8.9  ASCII/Byte/Word/Long/Single Float/Double Float

これらの6つの項目の左に付いているチェックマークは、現在の表示フォー
マットを示しています。異なる項目を選択して、そのフォーマットに変更す
ることができます。
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13.9 Performance Analysis

図 13.15　Performance Analysisウィンドウ

プログラムの実行効率データを表示して、制御するウィンドウです。デフォ
ルトで表示される項目は、削除または変更することはできません。表示内容
および動作はデバッグプラットフォームにより異なります。デバッグプラッ
トフォーム固有のパフォーマンスについては別冊の『デバッグプラットフォ
ームのマニュアル』を参照してください。
表示領域内でマウスの右ボタンをクリックするとポップアップメニューが表
示されます。このメニューには以下のオプションが含まれています。

13.9.1  Add Range

Add PA Rangeダイアログボックスを表示します。ソース行またはアドレス
範囲に基づいて新しいユーザ範囲を追加します。範囲名は編集可能です。

13.9.2  Edit Range

反転表示カーソルバーがユーザ定義範囲にある場合にのみ有効です。Edit PA
Rangeダイアログボックスを表示して、範囲の設定を変更します。

13.9.3  Delete Range

反転表示カーソルバーがユーザ定義範囲にある場合にのみ有効です。範囲設
定を削除し、他の範囲のデータを再計算します。

13.9.4  Reset Counts/Times

現在のプログラムの実行効率データをクリアします。

13.9.5  Delete All Ranges

現在のユーザ定義範囲をすべて削除し、実行効率測定データをクリアしま
す。

13.9.6  Analysis Enabled

実行効率データ収集のオン・オフを切り替えます。実行効率測定が現在アク
ティブであれば、テキストの左にチェックマークが表示されます。
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13.10 Registers

図 13.16　Registersウィンドウ

現在のレジスタ値を表示・変更できるウィンドウです。ウィンドウ内でマウ
スの右ボタンをクリックするとポップアップメニューが表示されます。この
メニューには以下のオプションが含まれています。

13.10.1  Copy

テキストブロックが反転表示されている場合にのみ使用できます。反
転表示されたテキストをWindows®クリップボードにコピーし、他のアプリ
ケーションに貼り付けられるようにします。

13.10.2  Edit...

Registerダイアログボックスを表示します。テキストカーソル (マウスカー
ソルではありません)の位置によって示されたレジスタの値を設定します。

13.10.3  Toggle Bit

テキストカーソルが、たとえばステータスレジスタ内のフラグなどのビット
フィールド上にある場合にのみ使用できます。ビットの現在のステータス
を、もう一方のステータスに変更します。たとえば、設定したオーバーフロ
ーフラグをクリアすることができます。

13.11 Source
Sourceウィンドウは、C/C++、アセンブラプログラムで、デバッグオプショ
ンを指定されていれば表示できます。
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図 13.17　Sourceウィンドウ

各列に対してダブルクリック動作をサポートしています。
・ BP

クリックしたアドレス(PC)のブレークポイントの設定/解除
・ Address

Set Address ダイアログボックスを表示します。アドレスの入力ができ
ます。本ファイルの範囲内のアドレスのときに、カーソルは指定され
た位置までスクロールします。入力されたアドレスが別ファイルのと
きには、ウィンドウを新規にオープンしカーソルは、該当アドレスを
表示します。入力されたアドレスに対応するファイルがないときには、
新規にDisassemblyウィンドウをオープンします。多重定義関数名やク
ラス名が入力されたとき、Select Functionダイアログボックスをオープ
ンし関数を選択します。

・ Label
Labelダイアログボックスを表示します。新しいラベルを入力するかラ
ベル名の編集ができます。

・ Line
Set Lineダイアログボックスを表示します。ソースファイルの指定した
行を直接表示することができます。

・ Source
スタートメニューのHDIショートカットで設定されているエディタが該
当個所を表示します。

右クリックするとBP行に現在サポートされている標準ブレークポイントタ
イプを表示します。現在、選択されているブレークポイントタイプがメニュ
ーの左側にチェックされています。
ウィンドウ内のBP行以外のところで右クリックすると使用可能なオプショ
ンがポップアップメニューで表示されます。
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13.11.1  Copy

テキストブロックが反転表示されている場合にのみ使用できます。反
転表示されたテキストをWindows®クリップボードにコピーし、他のアプリ
ケーションに貼り付けられます。

13.11.2  Find

Findダイアログボックスを表示して、ソースファイル内で文字列を検
索します。ソース表示フォーマットでのみ使用できます。

13.11.3  Set Address

Set Addressダイアログボックスを表示します。新しい開始アドレスを入力す
ると、ウィンドウが更新され、ユーザが入力したアドレスが左上端のアドレ
スとなります。アドレスとして多重定義関数あるいはメンバ関数を含むクラ
ス名を入力した場合、Select Functionダイアログボックスが開くので、設定
する関数を選択します。

13.11.4  Set Line

Set Lineダイアログボックスを表示します。テキストカーソル (マウスカー
ソルではありません)を指定された行に移動します。ソース表示フォーマッ
トでのみ使用できます。

13.11.5  Go To Cursor

現在のPCアドレスからユーザプログラムの実行を開始します。プログ
ラムは、PCがテキストカーソル(マウスカーソルではありません)の位置によ
って指定されたアドレスに達するか、別のブレーク条件が成立するまで実行
されます。デバッグプラットフォームによってサポートされていない場合、
このメニューオプションはグレー表示されます。

13.11.6  Set PC Here
PCの値をテキストカーソル(マウスカーソルではありません)の位置によって指定され
たアドレスに変更します。

13.11.7  Instant Watch

変数名を現在のテキストカーソル(マウスカーソルではありません)の位置か
ら抜き出して名前とともにInstant Watchダイアログボックスを表示します。
ソース行が有効なときのみ機能します。

13.11.8  Add Watch

テキストカーソル (マウスカーソルではありません)の位置の表示から抽出
した名前を、ウォッチ変数のリストに追加します。Watchウィンドウが開い
ていない場合はこれを開いて、他のウィンドウの一番上に表示されます。ソ
ース行が有効なときのみ機能します。
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13.11.9  Go To Disassembly

現在のソース行に対応したアドレスのDisassembly表示を行います。

13.12 System Status

図 13.18　System Statusウィンドウ

デバッグプラットフォームの現在のステータスを表示できるウィンドウで
す。テキストは、標準セクション(EmulatorからCause of last breakまで)とデ
バッグプラットフォーム依存セクションという2つのセクションにより構成
されています。プラットフォーム依存セクションについては、別冊の『デバ
ッグプラットフォームのマニュアル』を参照してください。
ウィンドウ内でマウスの右ボタンをクリックするとポップアップメニューが
表示されます。このメニューには以下のオプションが含まれています。

13.12.1  Update

表示データを最新情報に更新します。

13.12.2  Copy

反転表示されたテキストをWindows®クリップボードにコピーし、他の
アプリケーションに貼り付けられます。テキストブロックが反転表示されて
いる場合にのみ使用できます。
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13.13 Trace

図 13.19　Traceウィンドウ

デバッグプラットフォームの現在のステータスに達するまでに実行された命
令シーケンスを表示するウィンドウです。表示は選択したデバッグプラット
フォームによって異なります。

列をダブルクリックするとそのアドレスのソースまたは逆アセンブルコード
を表示します。

コマンドボタンの機能は、以下に示したポップアップメニューオプションと
同じです。

13.13.1  Find

Trace Searchダイアログボックスを表示します。現在のトレースバッファ内
の特定のトレースレコードを検索できます。

13.13.2  Find Next

トレースレコードが検索できた後、次の同様のトレースレコードをさらに検
索できます。

13.13.3  Filter

Filter Traceダイアログボックスを表示します。必要でないトレースエントリ
を、マスクできます。

13.13.4  Acquisition

Trace Acquisitionダイアログボックスを表示します。トレースするユーザプ
ログラム領域を指定します。これは問題のある領域にトレースを集中させる
ために使用することができます。

13.13.5  Halt

ユーザプログラムの実行を中止せずにトレースデータの収集を中止し、トレ
ース情報を更新します。

13.13.6  Restart

トレースデータの収集を開始します。
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13.13.7  Snapshot

ユーザプログラムの実行を中止せずに、トレース情報を更新してデバッグプ
ラットフォームの現在のステータスを表示します。

13.13.8  Clear

トレースバッファを空にします。複数のTraceウインドウが開いているとき
は、それらは同じバッファをアクセスしているため、すべてのトレースバッ
ファをクリアします。

13.13.9  Save

Save Asファイルダイアログボックスを表示します。トレースバッファの内
容をテキストファイルとして保存します。Cycleの範囲によって指定するか、
すべてのバッファを指定することができます(すべてのバッファをセーブす
るには、数分かかることがあります)。このファイルはトレースバッファに
再ロードできないことに注意してください。

13.13.10  View Source

該当アドレスに対応したソースプログラムや逆アセンブルを表示します。

13.13.11  Trim Source

ソースプログラムの左側の空白を取り除きます。

13.14 Watch

図 13.20　Watchウィンドウ

C/C++ソースレベルの変数を表示・変更することができるウィンドウです。
変数はリスト表示され、変数名をダブルクリックすれば情報を拡張表示でき
ることを示すプラス記号と、情報を収縮表示できることを示すマイナス記号
が付きます。また、’+’／’-’キーでも拡張／収縮表示することができます。
ウィンドウ内でマウスの右ボタンをクリックすると、ポップアップメニュー
が表示されます。このメニューには以下のオプションが含まれます。
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13.14.1  Copy

テキストブロックが反転表示されている場合にのみ使用できます。反
転表示されたテキストをWindows®クリップボードにコピーし、他のアプリ
ケーションに貼り付けられるようにします。

13.14.2  Delete

テキストカーソル (マウスカーソルではありません)の位置によって示され
た変数を、Watchウィンドウから削除します。

13.14.3  Delete All

すべての変数を、Watchウィンドウから削除します。

13.14.4  Add Watch

Add Watchダイアログボックスを表示します。監視する変数または式を入力
します。

13.14.5  Edit Value

Edit Watchダイアログボックスを表示して、変数の値を変更できるようにし
ます。ポインタの値を変更する場合は、そのポインタが有効なデータを指し
示さなくなる可能性があるため、特に注意が必要です。

13.14.6  Radix

選択しているウォッチ項目の表示基数を変更します。
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付録付録付録付録 AAAA システムモジュールシステムモジュールシステムモジュールシステムモジュール
本章では、HDIデバッグシステムのアーキテクチャを説明します。

HDI
グラフィカル

ユーザ

インタフェース

ターゲット

DLL
CPU
DLL

オブジェクト

DLL

ユーザコード

(オブジェクトファイル)

ターゲット

ハードウェア

エミュレータモニタ シミュレータ

デバッグ

プラットフォーム

IOファイル

図 A.1　HDIシステムモジュール

通常の動作では、ユーザプログラムをターゲットハードウェアに直接格納し
ます(たとえばEPROMとして)。HDIはこの情報を使用して、Windows®ベー
スのデバッグシステムを提供します。

異なるデバッグプラットフォームやターゲットハードウェアに交換したと
き、デバッグシステムの使用法を習熟する時間を短縮するため、 HDIは、
統一したインタフェース(GUI)とターゲット固有のモジュールファミリーを
提供しています。通常は､標準GUIは共通です。ユーザが適切なターゲット
モジュールを選択すれば、システムの残りの部分が自動的に適切なモジュー
ルをロードして自己設定します。

グラフィカルユーザインタフェース
これは、Windows®上で動くメインのHDI.EXEプログラムです。ユーザにな
じみのあるWindows®の操作を採用しており、メニューとウィンドウは、デ
バッグシステムの内容をユーザフレンドリーな方法で表示します。GUIは、
ユーザがシステムの残りの部分が接する唯一の接点であり、コマンドを処理
して、ユーザプログラムに関する必要な情報を提供します。また、モジュー
ルDLLとホストファイルシステム、すなわちPCとの間のインタフェースも
提供します。
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オブジェクト DLL
コンパイラツールはユーザプログラムを作成する際、アブソリュートファイ
ルを作成します。このファイルには、ターゲットアプリケーションを構成す
る機能を実行するため、マイクロコンピュータが処理する実際のマシンコー
ドおよびデータが含まれます。オリジナルソースコードとしてユーザプログ
ラムをデバッグするためには、コンパイラツールはデバッガにさらに情報を
提供しなければなりません。このため、コンパイラツールは、ソースコード
のデバッグに必要なすべての情報をアブソリュートファイルに格納するデバ
ッグオプションを備えています。このようなアブソリュートファイルは通
常、デバッグオブジェクトファイルと呼ばれます。

オブジェクトDLLは、オブジェクトファイルからこの情報を抽出し、ユーザ
に対して表示します。データのフォーマットはコンパイラツールに依存する
ため、HDIディレクトリには複数のオブジェクトDLLを入れておくことがで
きます。HDIはオブジェクトファイルのフォーマットが理解できるオブジェ
クトDLLをみつけるまで、1つ1つを試します。

CPU DLL
CPU DLLモジュールには、ターゲットのマイクロコンピュータに関する情
報が含まれています。たとえば、マイクロコンピュータが使用できる、レジ
スタの数と種類が含まれており、また、ターゲット中のマシンコードとSource
ウィンドウに表示するアセンブラニーモニックとの間で、翻訳を行います。

ターゲット DLL
ターゲットDLLは、デバッグプラットフォームの機能をHDIに通知し、正し
いCPU DLLを選択します。ターゲットの幾つかの機能は、一般的になり得
ません(たとえばターゲット構成)。ターゲットDLLには、これらの機能への
アクセスをユーザに提供するため、標準GUIへの拡張機能も含まれていま
す。

ターゲットDLLで使用できる機能の詳しい説明については、各『デバッグプ
ラットフォームのマニュアル』を参照してください。
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付録付録付録付録 BBBB コマンドラインフォーマットコマンドラインフォーマットコマンドラインフォーマットコマンドラインフォーマット

HDI 搭載コマンド
以下のコマンドは、HDIで使用することができる標準コマンドです。

! (コメントコメントコメントコメント)
省略形: なし

説明:
ログファイル等への記録に便利な、コメントを出力することができます。

シンタックス
!  <text>
パラメータ 型 説明
<text> テキスト 出力するテキスト

例:
! Start of test routine Command Lineウィンドウ（ログが有効の場合はログファイル）にコ

メント "Start of test routine" を出力します

ACCESS
省略形: AC

説明:
不正アクセス時の処理を設定、または表示します。

シンタックス
access  [ <state> ]
パラメータ 型 説明
なし 現在の設定を表示します
<state> キーワード 処理を設定します

break ブレークします(デフォルト)
none なにもしません

不正アクセスとは、ユーザプログラム実行中にプロテクトエリアへの書き込み、内蔵ROM
への書き込み、またはメモリマップされない領域へのアクセスなどのことです。

例:
ACCESS break 不正アクセスがあったらブレークします(デフォルト設定)
AC 現在設定されている不正アクセス時の処理を表示します
AC  none 不正アクセスがあっても何もしません
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ANALYSIS
省略形: AN

説明:
性能分析範囲を有効、または無効にします。分析数は、実行前に自動的にリセットされま
せん。

シンタックス
an  [ <state> ]
パラメータ 型 説明
なし 分析状況を表示します
<state> キーワード 分析を設定します

enable 分析を可能にします
disable 分析を無効にします
reset 分析数をリセットします

例:
ANALYSIS 分析状況を表示します
AN enable 分析を可能にします
AN disable 分析を無効にします
AN reset 分析数をリセットします

ANALYSIS_RANGE
省略形: AR

説明:
性能分析範囲を設定するか、またはパラメータなしで性能分析範囲を表示します。シンタ
ックスはデバッグプラットフォームによって異なります。別冊の『デバッグプラット
フォームのマニュアル』を参照してください。

シンタックス
ar  [  <start>  <end>  [ <name> ]  ]
パラメータ 型 説明
なし すべての性能分析範囲を表示します
<start> 数値 性能分析範囲の開始アドレス
<end> 数値 性能分析範囲の終了アドレス
<name> 文字列 性能分析範囲の名称

例:
ANALYSIS_RANGE H'’0 H’100 アドレス H'0 - H'100の性能分析範囲を定義します
AR H’1000 H’3FFF アドレス H'1000 - H'3FFFの性能分析範囲を定義します
AR 性能分析範囲設定を表示します
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ANALYSIS_RANGE_DELETE
省略形: AD

説明:
指定された項目番号の性能分析範囲、またはパラメータが何も指定されていなかったらす
べての性能分析範囲を削除します(確認を求められません)。

シンタックス
ad  [ <index> ]
パラメータ 型 説明
なし すべての性能分析範囲を削除します
<index> 数値 削除する性能分析範囲の番号

例:
ANALYSIS_RANGE_DELETE 6 システムから項目番号 6の性能分析範囲を削除します
AD すべての性能分析範囲を削除します

ASSEMBLE
省略形: AS

説明:
メモリにアセンブルします。
アセンブルモードでは "." は終了、"^" は1バイト戻り、ENTERキーを押すと先に進みま
す。
シンタックス
as  <address>
パラメータ 型 説明
<address> 数値 アセンブルを開始するアドレス

例:
AS H’1000 H'1000からアセンブルします

ASSERT
省略形: なし

説明:
式が真であることを調べます。 式が偽のときはバッチファイルを終了するため、バッチフ
ァイルで使えます。 式は偽のときエラーが返されます。 このコマンドは、サブルーチン
のテストハーネスを記述するために使うことができます。

シンタックス
assert  <expression>
パラメータ 型 説明
<expression> 式 判定する式

例:
ASSERT #R0 == 0x100 R0 が 0x100を含んでいないときエラーを返します
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DISASSEMBLE
省略形: DA

説明:
アセンブルコードのメモリを逆アセンブル表示します。 逆アセンブル表示は完全なシンボ
リックです。

シンタックス
da  <address>  [<length>]
パラメータ 型 説明
<address> 数値 開始アドレス
<length> 数値 命令数（任意、デフォルト=16）

例:
DISASSEMBLE H’100 5 アドレス H'100からコード 5行を逆アセンブル表示します
DA H’3E00 20 アドレス H'3E00からコード 20行を逆アセンブル表示します

ERASE
省略形: ER

説明:
Command Lineウィンドウをクリアします。

シンタックス
er
パラメータ 型 説明
なし Command Lineウィンドウをクリアします

例:
ER Command Lineウィンドウをクリアします

EVALUATE
省略形: EV

説明:
簡単な式、そして括弧、混合基数とシンボルを持つ複雑な式を評価することができます。 す
べての演算子は同じ優先順位を持っていますが、括弧は評価の順序を変更することができ
ます。 演算子はC/C++と同じ意味を持っています。 式もまた数値が要求されるコマンド
で使うことができます。 レジスタ名を使うことができすが、通常文字で前定義されなけれ
ばいけません。結果は、16進、10進、8進、2進で表示されます。

シンタックス
ev  <expression>
パラメータ 型 説明
<expression> 式 評価する式

有効な演算子:
&& 論理 AND || 論理 OR << 左算術シフト >> 右算術シフト
+  加算 -  減算 *  乗算 /  除算
%  剰余 |  ビット毎の OR &  ビット毎の AND ~  ビット毎の NOT
^  ビット毎の排他的 OR !  論理 NOT == 等しい != 等しくない
>  より大きい <  より小さい >= 以上 <= 以下
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例:
EV H’123 + (D’73 | B’10) 結果:  H'16E  D'366  O'556

B'00000000;00000000;00000001;01101110
EV #R2H * #R2L 結果:  H'121  D'289  O'441

B'00000000;00000000;00000001;00100001

FILE_LOAD
省略形: FL

説明:
指定されたオフセットで、メモリに対して指定されたファイルをロードします。 現在のシ
ンボルはクリアされますが、新しいシンボルが同一名で現在のシンボルを重複定義します。
オフセットが指定されるとシンボルに加えられます。ファイルの拡張子はデフォルトとし
て.MOTを設定します。

シンタックス
fl  <filename>  [ <offset> ] [ <state> ]
パラメータ 型 説明
<filename> 文字列 ファイル名
<offset> 数値 ロードアドレスに加えるオフセットを設定します

（任意、デフォルト=0）
<state> キーワード ベリファイフラグ（任意、デフォルト=V)

V ベリファイあり
N ベリファイなし

例:
FILE_LOAD A:¥¥BINARY¥¥TESTFILE.A22 S レコードファイル "testfile.a22" をロードし

ます
FL ANOTHER.MOT H’200 モトローラ Sレコードファイル "another.mot"

をオフセット H'200バイトからロードします

FILE_SAVE
省略形: FS

説明:
メモリエリアをファイルへ保存します。 データはモトローラ S レコードフォーマットで
保存されます。すでに存在するファイル名を指定した場合は、上書きするかどうかユーザ
に確認します。ファイルの拡張子のデフォルトは、.MOTです。シンボルは自動的にセーブ
されません。

シンタックス
fs  <filename>  <start>  <end>
パラメータ 型 説明
<filename> 文字列 ファイル名
<start> 数値 開始アドレス
<end> 数値 終了アドレス

例:
FILE_SAVE TESTFILE H’0 H’2013 アドレス範囲 H'0 - H'2013をモトローラ

Sレコードファイル "TESTFILE.MOT"
として保存します

FS D:¥¥USER¥¥ANOTHER.A22 H’4000
H’4FFF

アドレス範囲 H'4000 - H'4FFFを Sレコ
ードフォーマットファイル
"ANOTHER.A22" として保存します
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FILE_VERIFY
省略形: FV

説明:
メモリとファイル内容をベリファイします。 ファイルデータはモトローラ S レコードフ
ォーマットです。ファイルの拡張子はデフォルトとして.MOTを設定します。

シンタックス
fv  <filename>  [ <offset> ]
パラメータ 型 説明
<filename> 文字列 ファイル名
<offset> 数値 ファイルアドレスへ加えるオフセットを設定します

（任意、デフォルト=0）

例:
FILE_VERIFY A:¥¥BINARY¥¥TEST.A22 メモリに対して S レコードファイル

"TEST.A22" をベリファイします
FV ANOTHER 200 メモリに対して S レコードファイル

"ANOTHER.MOT" にオフセット H'200バイ
トを加えたアドレスからベリファイします

GO
省略形: GO

説明:
ユーザプログラムを実行します。ユーザプログラムが実行されているとき、Performance
Analysis ウィンドウは更新されます。ユーザプログラムが停止すると、PC値が表示されま
す。

シンタックス
go  [ <state> ]  [ <address> ]
パラメータ 型 説明
<state> キーワード プログラム実行中でのコマンド処理の有効／無効

（任意、デフォルト= wait ）
wait コマンド処理を続けることができません
continue コマンド処理を続けることができます

<address> 数値 PC のための開始アドレス（任意、デフォルト=PC値）

wait はデフォルトで、プログラムが実行を停止するまでコマンド処理ができません。
continue は、コマンド処理を続けることができます（デバッグプラットフォームの機能に
より動作しないものもあります）。

例:
GO 現在の PCからユーザプログラムを実行します

(コマンド処理を続けることができません)
GO CONTINUE H’1000 H'1000からユーザプログラムを実行します

(コマンド処理を続けることができます)
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GO_RESET
省略形: GR

説明:
リセットベクタで指定されているアドレスから始まるユーザプログラムを実行します。ユ
ーザプログラムが実行されているとき、Performance Analysisウィンドウは更新されます。

シンタックス
gr  [ <state> ]
パラメータ 型 説明
<state> キーワード プログラム実行中でのコマンド処理の有効／無効

（任意、デフォルト= wait ）
wait コマンド処理を続けることができません
continue コマンド処理を続けることができます

wait はデフォルトで、プログラムが実行を停止するまでコマンド処理ができません。
continue は、コマンド処理を続けることができます（デバッグプラットフォームの機能
により動作しないものもあります）。

例:
GR リセットベクタで指定されているアドレスから始まる、ユ

ーザプログラムを実行します
(コマンド処理を続けることができません)

GO_TILL
省略形: GT

説明:
テンポラリブレークポイントを設定し、カレントの PC からプログラムを実行します。 テ
ンポラリブレークポイントとして、複数のアドレスを指定することができます（テンポラ
リブレークポイントは、コマンド実行中のみ有効です）。

シンタックス
gt  [ <state> ]  <address>...
パラメータ 型 説明
<state> キーワード プログラム実行中でのコマンド処理の有効／無効

wait コマンド処理を続けることができません
continue コマンド処理を続けることができます

<address>... 数値 テンポラリブレークポイントのアドレス（リスト）

wait はデフォルトで、プログラムが実行を停止するまでコマンド処理ができません。
continue は、コマンド処理を続けることができます（デバッグプラットフォームの機能
により動作しないものもあります）。

例:
GO_TILL H’1000 PC がアドレス H'1000に到達するまでユーザプログラムを実

行します
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HALT
省略形: HA

説明:
ユーザプログラムを停止します（"go continue"コマンドの後で、使うことができます）。

シンタックス
ha
パラメータ 型 説明
なし ユーザプログラムを停止します

例:
HA ユーザプログラムを停止します

HELP
省略形: HE

説明:
ヘルプファイルを開きます。

コンテキスト詳細ヘルプは、F1キーで表示できます。同じことをコマンドラインで HELP、
または HE、続いてコマンド名を入力することにより検索できます。

シンタックス
he  [ <command> ]
パラメータ 型 説明
なし ヘルプの目次を表示します
<command> 文字列 コマンドを指定します

例:
HE ヘルプの目次を表示します
HE GO GO コマンドのヘルプを表示します

INITIALISE
省略形: IN

説明:
HDI（デバッグプラットフォームを含む）、ターゲット（ターゲットライブラリを再選択
するように）を初期化します。すべてのブレークポイント、メモリマッピングなどもリセ
ットされます。

シンタックス
in
パラメータ 型 説明
なし HDI を初期化します

例:
IN HDI を初期化します
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INTERRUPTS
省略形: IR

説明:
割り込みを有効、または無効にするか、CPUの割り込み優先度レベルを設定します。 この
コマンドは CPU Status Register（SR、または CCR）を変更することにより操作します。

注意注意注意注意:  このコマンドは、デバッグプラットフォームによってサポートされてないことが
あります。

シンタックス
ir  [  <state>  |  <level>  ]
パラメータ 型 説明
なし CPU 割り込み状態を表示します
<state> キーワード 割り込みの有効／無効

enable すべての割り込みを有効にします
disable すべての割り込みを無効にします（NMI を除く）

<level> 数値 割り込み優先度レベルを設定します

例:
IR CPU 割り込み状態を表示します
IR ENABLE すべての割り込みを有効にします
IR DISABLE すべての割り込みを無効にします（NMI を除く）
IR 5 割り込み優先度レベル 5を設定します

LOG
省略形: LO

説明:
ファイルへのコマンド出力のログを制御します。 パラメータなしでは、現在のログ状況が
表示されます。 存在するファイルを指定すると、追加するかユーザに確認され、No と答
えるとデータはファイルに上書きされ、Yes と答えるとファイルに追加されます。 ロギン
グはコマンドラインインタフェースでのみサポートされます。

シンタックス
lo  [  <state>  |  <filename>  ]
パラメータ 型 説明
なし ロギング状態を表示します
<state> キーワード ロギングを再開／停止します

+ ロギングを再開します
- ロギングを停止します

<filename> 文字列 ロギングを出力するファイル名を指定します

例:
LOG TEST ファイル TEST のリストボックスへの出力をロギングします
LO - ロギングを停止します
LOG + ロギングを再開します
LOG カレントのロギング状態を表示します
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MAP_DISPLAY
省略形: MA

説明:
現在のメモリマップ構成を表示します。

シンタックス
ma
パラメータ 型 説明
なし 現在のメモリマップ構成を表示します

例:
MA 現在のメモリマップ構成を表示します

MEMORY_DISPLAY
省略形: MD

説明:
メモリ内容を表示します。

シンタックス
md  <address>  [ <length> ]  [ <mode> ]
パラメータ 型 説明
<address> 数値 開始アドレス
<length> 数値 長さ（任意、デフォルト=H'100バイト）
<mode> キーワード フォーマット（任意、デフォルト=byte）

byte バイトとして表示します
word ワードとして表示します（2バイト）
long ロングワードとして表示します（4バイト）
ascii ASCII として表示します
single 単精度浮動小数点として表示します
double 倍精度浮動小数点として表示します

例:
MEMORY_DISPLAY H’C000 H’100 WORD H'C000から始まるメモリを H'100バイト

分ワードフォーマットで表示します
MEMORY_DISPLAY H’1000 H’FF H'1000から始まるメモリを H'FFバイト

分バイトフォーマットで表示します

MEMORY_EDIT
省略形: ME

説明:
メモリ内容を変更します。 メモリを変更するとき、カレント位置は ASSEMBLE コマン
ドで記述したときと同じような方法で変更することができます。"." を入力すると変更モー
ドを終了し、"^" は1ユニット戻り、空白は変更せずに進みます。
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シンタックス
me  <address>  [ <mode> ]  [ <state> ]
パラメータ 型 説明
<address> 数値 変更するアドレス
<mode> キーワード フォーマット（任意、デフォルト=byte）

byte バイトとして変更します
word ワードとして変更します
long ロングワードとして変更します
ascii ASCII として変更します
single 単精度浮動小数点として表示します
double 倍精度浮動小数点として表示します

<state> キーワード ベリファイフラグ（任意、デフォルト=V)
V ベリファイあり
N ベリファイなし

例:
ME H’1000 WORD H'1000から wordフォーマットでメモリ内容を変更しま

す(ベリファイあり)

MEMORY_FILL
省略形: MF

説明:
メモリ領域を指定されたデータ値に変更します。

シンタックス
mf  <start>  <end>  <data>  [ <mode> ]  [ <state> ]
パラメータ 型 説明
<start> 数値 開始アドレス
<end> 数値 終了アドレス
<data> 数値 データ値
<mode> キーワード データサイズ（任意、デフォルト=byte）

byte バイト
word ワード
long ロングワード
single 単精度浮動小数点
double 倍精度浮動小数点

<state> キーワード ベリファイフラグ（任意、デフォルト=V)
V ベリファイあり
N ベリファイなし

例:
MEMORY_FILL H’C000 H’C100 H’55AA WORD H'C000から H'C0FFまでワードデー

タ H'55AAに変更します
MF H’5000 H’7FFF H’21 H'5000から H'7FFFまでデータ H'21

に変更します
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MEMORY_MOVE
省略形: MV

説明:
メモリ領域を移動します。

シンタックス
mv  <start>  <end>  <dest> [ <state> ]
パラメータ 型 説明
<start> 数値 ソース開始アドレス
<end> 数値 ソース終了アドレス（この値を含む）
<dest> 数値 移動先開始アドレス
<state> キーワード ベリファイフラグ（任意、デフォルト=V)

V ベリファイあり
N ベリファイなし

例:
MEMORY_MOVE H’1000 H’1FFF H’2000 領域 H'1000 - H'1FFFを H'2000へ移動します
MV H’FB80 H’FF7F H’3000 領域 H'FB80 - H'FF7Fを H'3000へ移動します

MEMORY_TEST
省略形: MT

説明:
指定されたアドレス範囲で、リード・ライト・ベリファイのテストを行います。このとき
のデータは破壊されます。 テストはマップ環境によりメモリをアクセスします。

シンタックス
mt  <start>  <end>
パラメータ 型 説明
<start> 数値 開始アドレス
<end> 数値 終了アドレス（この値を含む）

例:
MEMORY_TEST H’8000 H’BFFF H'8000から H'BFFFまでテストします
MT H’4000 H’5000 H'4000から H'5000までテストします

QUIT
省略形: QU

説明:
HDI を終了します。 ログファイルがオープンしていると閉じられます。
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シンタックス
qu
パラメータ 型 説明
なし HDI を終了します

例:
QU HDI を終了します

RADIX
省略形: RA

説明:
デフォルトの基数を設定、または表示します。 パラメータなしで基数を表示します。
基数は数値データの前の B'/H'/D'/O' を使って変更できます。

シンタックス
ra  [ <mode> ]
パラメータ 型 説明
なし 現在の基数を表示します
<mode> キーワード 基数指定子

H 16進数
D 10進数
O 8進数
B 2進数

例:
RADIX 現在の基数を表示します
RA H 基数を 16進数にします

REGISTER_DISPLAY
省略形: RD

説明:
CPUレジスタ値を表示します。

シンタックス
rd
パラメータ 型 説明
なし 全レジスタの内容を表示します

例:
RD 全レジスタの内容を表示します
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REGISTER_SET
省略形: RS

説明:
CPUレジスタ値を変更します。

シンタックス
rs  <register>  <value>  <mode>
パラメータ 型 説明
<register> キーワード レジスタ名
<value> 数値 レジスタ値
<mode> キーワード データサイズ（任意、デフォルト=レジスタサイズ）

byte バイト
word ワード
long ロングワード
single 単精度浮動小数点
double 倍精度浮動小数点

例:
RS PC _SrartUp プログラムカウンタをシンボル_StartUpに設定します
RS R0 H’1234 WORD R0にワードデータ H'1234に設定します

RESET
省略形: RE

説明:
プロセッサをリセットします。 すべてのレジスタ値はデバイスの初期化状態に設定されま
す。 メモリマッピングとブレークポイントは影響されません。

シンタックス
re
パラメータ 型 説明
なし プロセッサをリセットします

例:
RE プロセッサをリセットします

SLEEP
省略形: なし

説明:
指定されたミリ秒の間コマンド実行を遅延します。

シンタックス
sleep  <milliseconds>
パラメータ 型 説明
<milliseconds> 数値 遅延時間（ミリ秒）

基数 D’ は、明示して使わないとデフォルトの基数（必ずしも10進ではありません）が使
われます。

例:
SLEEP D’9000 9秒間遅延します
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STEP
省略形: ST

説明:
シングルステップ（ソース行、または命令）を行ないます。カレントの PC から指定され
た命令数分ステップします。ソースデバッグが有効な時、デフォルトのステップはソー
ス行によって行われます。ステップ数のデフォルトは1です｡

シンタックス
st  [ <mode> ]  [ <count> ]
パラメータ 型 説明
<mode> キーワード ステップの種類（任意）

instruction アセンブラの 1命令を基準にステップします
line ソースコードの 1行を基準にステップします

<count> 数値 ステップ数（任意、デフォルト=1）

例:
STEP 9 9ステップコードをステップします

STEP_OUT
省略形: SP

説明:
カレントの関数の外へプログラムをステップします（即ち、ステップアップ）。 アセンブ
ラとソースレベルデバッグの両方に有効です。

シンタックス
sp
パラメータ 型 説明
なし ステップアップします

例:
SP 現在の関数の外へプログラムをステップします

STEP_OVER
省略形: SO

説明:
カレントの PC から指定された命令数分ステップします。
このコマンドはサブルーチン、または割り込みルーチンの中でステップしないという点で
STEPとは異なります。フルスピードで実行されます。

シンタックス
so  [ <mode> ]  [ <count> ]
パラメータ 型 説明
<mode> キーワード ステップの種類（任意）

instruction アセンブラの 1命令を基準にステップします
line ソースコードの 1行を基準にステップします

<count> 数値 ステップ数（任意、デフォルト=1）

例:
SO 1ステップコードをステップオーバーします
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STEP_RATE
省略形: SR

説明:
STEPとSTEP_OVERコマンドでステップの速度をコントロールします。 6レートは最大限
に速くステップします。 値が1の場合は最も遅いステップです。

シンタックス
sr  [ <rate> ]
パラメータ 型 説明
なし ステップレートを表示します
<rate> 数値 ステップレート 1から 6で 6が最も速くなります

例:
SR 現在設定されているステップレートを表示します
SR 6 ステップレートを最速にします

SUBMIT
省略形: SU

説明:
エミュレータコマンドのファイルを処理します。 処理するファイル中でもこのコマンドを
使用できます。 エラーが発生するとファイルの処理を中止します。 [stop]ボタンでプロセ
スを中止することができます。

シンタックス
su  <filename>
パラメータ 型 説明:
<filename> 文字列 ファイル名

例:
SUBMIT COMMAND.HDC COMMAND.HDC ファイルを処理します
SU A:SETUP.TXT ドライブ A: の SETUP.TXT ファイルを処理します

SYMBOL_ADD
省略形: SA

説明:
新しいシンボルを追加するか、または存在しているシンボルを変更します。

シンタックス
sa  <symbol>  <value>
パラメータ 型 説明
<symbol> 文字列 シンボル名
<value> 数値 値

例:
SYMBOL_ADD start H’1000 H'1000に start を定義します
SA END_OF_TABLE 1000 カレントのデフォルト基数を使い、1000に END_OF_TABLE

を定義します
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SYMBOL_CLEAR
省略形: SC

説明:
シンボルを削除します。 パラメータを指定しないとすべてのシンボルを削除します。

シンタックス
sc  [ <symbol> ]
パラメータ 型 説明
なし すべてのシンボルを削除します
<symbol> 文字列 シンボル名

例:
SYMBOL_CLEAR すべてのシンボルを削除します
SC start シンボル start を削除します

SYMBOL_LOAD
省略形: SL

説明:
ファイルからシンボルをロードします。 ファイルは XLINK Pentica-b フォーマット（即ち
"XXXXH name"）である必要があります。 シンボルは存在するシンボルテーブルに加えら
れます。 シンボルファイル拡張子は .SYM をデフォルトに設定します。

シンタックス
sl  <filename>
パラメータ 型 説明
<filename> 文字列 ファイル名

例:
SYMBOL_LOAD TEST.SYM ファイル TEST.SYM をロードします
SL MY_CODE.SYM ファイル MY_CODE.SYM をロードします

SYMBOL_SAVE
省略形: SS

説明:
すべてのシンボルをファイルへ保存します。 ファイルは XLINK Pentica-b フォーマットで
ある必要があります。 シンボルファイル拡張子は .SYM をデフォルトとします。 ファイ
ル名は、既に存在するときファイルを上書きするプロンプトが表示されます。

シンタックス
ss  <filename>
パラメータ 型 説明
<filename> 文字列 ファイル名

例:
SYMBOL_SAVE TEST TEST.SYM にシンボルテーブルを保存します
SS MY_CODE.SYM MY_CODE.SYM にシンボルテーブルを保存します
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SYMBOL_VIEW
省略形: SV

説明:
定義されたすべてのシンボル、または指定した文字列（大文字／小文字は区別する）を含
んでいるシンボルを表示します。

シンタックス
sv  [ <pattern> ]
パラメータ 型 説明
なし すべてのシンボルを表示します
<pattern> 文字列 文字列を含んでいるシンボル

例:
SYMBOL_VIEW BUFFER BUFFER を含んでいるすべてのシンボルを表示します
SV すべてのシンボルを表示します

TRACE
省略形: TR

説明:
トレースバッファの内容を表示します。 遅延トレースが設定されていないとき、バッファ
での最後の（最も最近実行された）サイクルはサイクル0で、それ以前のサイクルは負の値
を持っています。 トレース遅延が設定されているとき、レベル1のブレークポイントが発
生したサイクルはサイクル0で、最も新しいサイクルはトレース遅延値の数を示します。

シンタックス
tr  [ <start rec>  [ <count> ] ]
パラメータ 型 説明
<start rec> 数値 オフセット（任意、デフォルト=最も新しいサイクル-9）
<count> 数値 カウント（任意、デフォルト= 10）

例:
TR -10 5 サイクル-10から 5行トレースバッファの内容を表示します
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デバッグプラットフォーム特有コマンド
次のコマンドは、デバッグプラットフォーム単位に特有なコマンドです。詳細につい
ては、別冊の『デバッグプラットフォームのマニュアル』を参照してください。

ANALYSIS_RANGE
BREAKPOINT
BREAKPOINT_CLEAR
BREAKPOINT_DISPLAY
BREAKPOINT_ENABLE
BREAKPOINT_SEQUENCE
BREAK_ACCESS
BREAK_CLEAR
BREAK_DATA
BREAK_DISPLAY
BREAK_ENABLE
BREAK_REGISTER
BREAK_SEQUENCE
CLOCK
DEVICE_TYPE
MAP_SET
MODE
REFRESH
TEST_EMULATOR
TIMER
TRACE_ACQUISITION
TRACE_COMPARE
TRACE_SAVE
TRACE_SEARCH
USER_SIGNAL
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付録付録付録付録 CCCC コマンドライン一覧表コマンドライン一覧表コマンドライン一覧表コマンドライン一覧表

コマンド名 短縮形 説   明
! - コメント
ACCESS AC 不正アクセスに対する動作の設定
ANALYSIS AN 性能分析機能の有効化／無効化
ANALYSIS_RANGE AR 性能分析範囲の設定、表示
ANALYSIS_RANGE_DELETE AD 性能分析範囲の削除
ASSEMBLE AS アセンブルの実行
ASSERT - コンディションのチェック
BREAKPOINT BP ブレークポイントの設定
BREAKPOINT_CLEAR BC ブレークポイントの削除
BREAKPOINT_DISPLAY BD ブレークポイントの表示
BREAKPOINT_ENABLE BE ブレークポイントの有効化／無効化
BREAKPOINT_SEQUENCE BS イベントシーケンスの設定、削除
BREAK_ACCESS BA メモリ範囲のアクセスによるブレークポイン

トの設定
BREAK_CLEAR BC ブレークポイントの削除
BREAK_DATA BD メモリのデータ値によるブレーク条件の設定
BREAK_DISPLAY BI ブレークポイントの表示
BREAK_ENABLE BE ブレークポイントの有効化／無効化
BREAK_REGISTER BR レジスタのデータ値によるブレークポイント

の設定
BREAK_SEQUENCE BS 実行順序を指定したブレークポイントの設定
CLOCK CK エミュレータの CPUクロック時間の設定
DEVICE_TYPE DE エミュレータのデバイスタイプの選択
DISASSEMBLE DA 逆アセンブル表示
ERASE ER Command Lineウィンドウの内容のクリア
EVALUATE EV 式の計算
FILE_LOAD FL オブジェクト(プログラム)ファイルのロード
FILE_SAVE FS メモリ内容のファイルセーブ
FILE_VERIFY FV ファイル内容とメモリ内容の比較
GO GO ユーザプログラムの実行
GO_RESET GR リセットベクタからのユーザプログラムの実

行
GO_TILL GT テンポラリブレークポイントまでのユーザプ

ログラムの実行
HALT HA ユーザプログラムの停止
HELP HE コマンドラインまたはコマンドに対するヘル

プ表示
INITIALISE IN プラットフォームの初期化
INTERRUPTS IR プラットフォームの割り込み処理の有効化／

無効化
LOG LO ロギングファイルの操作
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MAP_DISPLAY MA メモリマッピング情報の表示
MAP_SET MS メモリマッピングの設定
MEMORY_DISPLAY MD メモリ内容の表示
MEMORY_EDIT ME メモリ内容の変更
MEMORY_FILL MF 指定データによるメモリ内容の一括変更
MEMORY_MOVE MV メモリブロックの移動
MEMORY_TEST MT メモリブロックのテスト
MODE MO CPUモードの設定、表示
QUIT QU HDIの終了
RADIX RA 入力ラディックス(基数)の設定
REFRESH RF メモリ関連ウインドウの更新
REGISTER_DISPLAY RD CPUレジスタ値の表示
REGISTER_SET RS CPUレジスタ値の設定
RESET RE CPUのリセット
SLEEP - コマンド実行の遅延
STEP ST ステップ実行(命令単位またはソース行単位)
STEP_OUT SP PC 位置の関数を終了するまでのステップ実

行
STEP_OVER SO ステップオーバー実行
STEP_RATE SR ステップ実行速度の設定、表示
SUBMIT SU エミュレータコマンドファイルの実行
SYMBOL_ADD SA シンボルの設定
SYMBOL_CLEAR SC シンボルの削除
SYMBOL_LOAD SL シンボル情報ファイルのロード
SYMBOL_SAVE SS シンボル情報のファイルセーブ
SYMBOL_VIEW SV シンボルの表示
TEST_EMULATOR TE エミュレータハードウェアのテスト
TIMER TI 実行時間測定タイマの分解能の設定、表示
TRACE TR トレース情報の表示
TRACE_ACQUISITION TA トレース取得条件の設定、表示
TRACE_COMPARE TC トレースファイルと現在のトレース情報を比

較
TRACE_SAVE TV トレース情報をトレースファイルに保存
TRACE_SEARCH TS トレース情報の検索
USER_SIGNALS US ユーザシグナル情報の有効化／無効化
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付録付録付録付録 DDDD    GUIコマンド一覧コマンド一覧コマンド一覧コマンド一覧

ﾒﾆｭｰﾒﾆｭｰﾒﾆｭｰﾒﾆｭｰ ﾒﾆｭｰｵﾌﾟｼｮﾝﾒﾆｭｰｵﾌﾟｼｮﾝﾒﾆｭｰｵﾌﾟｼｮﾝﾒﾆｭｰｵﾌﾟｼｮﾝ ｼｮｰﾄｶｯﾄｷｰｼｮｰﾄｶｯﾄｷｰｼｮｰﾄｶｯﾄｷｰｼｮｰﾄｶｯﾄｷｰ ﾂｰﾙﾊﾞｰﾎﾞﾀﾝﾂｰﾙﾊﾞｰﾎﾞﾀﾝﾂｰﾙﾊﾞｰﾎﾞﾀﾝﾂｰﾙﾊﾞｰﾎﾞﾀﾝ
File New Session... Ctrl+N

Load Session... Ctrl+O

Save Session Ctrl+S

Save Session As...
Load Program...

Initialize

Exit Alt+F4
Edit Cut Ctrl+X

Copy Ctrl+C

Paste Ctrl+V

Find F3

Evaluate

View Toolbar
Status bar
Breakpoints Ctrl+B
Command Line Ctrl+L

Disassembly... Ctrl+D

I/O Area Ctrl+I

Labels Ctrl+A

Locals Ctrl+Shift+W

Memory... Ctrl+M

Performance Analysis Ctrl+P

Registers Ctrl+R

Source... Ctrl+K

Status Ctrl+U

Trace Ctrl+T

Watch Ctrl+W

Run Reset CPU

Go F5
Reset Go Shift+F5
Go To Cursor
Set PC To Cursor

Run...
Step In F8
Step Over F7

Step Out
Step...

Halt Esc
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ﾒﾆｭｰﾒﾆｭｰﾒﾆｭｰﾒﾆｭｰ ﾒﾆｭｰｵﾌﾟｼｮﾝﾒﾆｭｰｵﾌﾟｼｮﾝﾒﾆｭｰｵﾌﾟｼｮﾝﾒﾆｭｰｵﾌﾟｼｮﾝ ｼｮｰﾄｶｯﾄｷｰｼｮｰﾄｶｯﾄｷｰｼｮｰﾄｶｯﾄｷｰｼｮｰﾄｶｯﾄｷｰ ﾂｰﾙﾊﾞｰﾎﾞﾀﾝﾂｰﾙﾊﾞｰﾎﾞﾀﾝﾂｰﾙﾊﾞｰﾎﾞﾀﾝﾂｰﾙﾊﾞｰﾎﾞﾀﾝ
Memory Refresh F12

Load...

Save...

Verify...

Test...

Fill...

Copy...

Compare...

Search...

Configure Map...

Configure Overlay...

Setup Options...

Radix (Input)            Ø
          Hexadecimal
          Decimal
          Octal
          Binary

Customize                             
          Toolbar...
          Font...
          File Filter...
Configure Platform...

Window Cascade
Tile
Arrange Icons

Close All
Help Index F1

Using Help
Search for Help on
About HDI
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付録付録付録付録 EEEE    I/Oレジスタファイルのフォーマットレジスタファイルのフォーマットレジスタファイルのフォーマットレジスタファイルのフォーマット
HDIは、I/Oレジスタ定義ファイルの情報に基づいて、I/O Registersウィンド
ウをフォーマットします。[Setup->Configure Platform...]メニューオプショ
ンを使用してデバッグプラットフォームを選択すると、HDIは、選択したデ
バイスに対応する“<device>.IO”ファイルを検索し、そのファイルが存在す
る場合にファイルをロードします。このファイルはフォーマット済みのテキ
ストファイルで、各I/Oモジュールおよびそれらのレジスタのアドレスとサ
イズが記述されています。テキストエディタを使用してこのファイルを編集
し、アプリケーションに固有のメモリマップレジスタまたは周辺レジスタ
(例：マイクロコンピュータのアドレス空間にマップされたASICデバイスの
レジスタなど)のサポートを追加できます。

ファイルのフォーマット
各モジュール名は[Modules]定義セクションで定義する必要があり、各モジ
ュールの番号は連続していなければなりません。モジュールごとにレジスタ
定義セクションがあり、そのセクション内の各エントリにより、I/Oレジス
タが定義されます。

Base Addressは、CPUモードに応じてI/Oレジスタの位置が移動するデバイス
で設定します。Base Addressには、あるモードでのI/Oレジスタの基準アドレ
スを設定し、レジスタ定義には、同一モードでの各レジスタのアドレスを設
定してください。I/Oレジスタが実際に使用される際には、レジスタ定義の
アドレスからBase Addressの値を差し引き、その結果求められたオフセット
値が選択されたモードでの基準アドレスに加算されます。

各モジュールの定義セクションには、依存関係を示すオプションで構成され
るレジスタを定義するセクションがあります。依存関係のオプションはモジ
ュールが使用可能かどうかをチェックすることができます。
各レジスタ名は連続な登録番号とともにセクションの中で定義します。
依存関係のオプションは以下のように定義されます。
dep=<reg> <bit> <value>

1．<reg>  ：オプションの登録IDです。
2．<bit>  ：レジスタ内のビット位置です。
3．<value>：モジュールがイネーブルになるためのビットの値です。
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[Register]定義エントリは次のフォーマットで定義されます。
id=<name> <address> [<size>[<absolute>[<format>[<bitfield>]]]]

1．<name>  ：レジスタ名
2．<address>：レジスタの値
3．<size>　 ：B(バイト)、W(ワード)、またはL(ロングワード)のいずれか
             です(デフォルトはバイトです)。
4．<absolute>：I/Oレジスタが絶対アドレスの場合は<absolute>に’A’ を指定
できます。’A’を指定した場合、基準アドレスのオフセット計算は行なわず、
指定されたアドレスを直接使用します。CPUモードによってI/Oレジスタの
位置が変わる場合は<absolute>を指定しないでください。
5．<format> ：レジスタの表示形式（H:16進数、D:10進数、B:2進数）
6．<bitfield> ：レジスタ内のビットを定義しているセクション名

ビットフィールドはレジスタ内のビットを以下のフォーマットで定義しま
す。
bit<no>=<name>

1．<no>  ：ビット番号
2．<name>：ビットのシンボル名

コメント行を付けることができますが、その場合は、“;”文字で始めなけれ
ばなりません。
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例:
; H8S/2655 Series I/O Register Definitions File

[Modules]
BaseAddress=0
Module1=Power_Down_Mode_Registers
Module2=DMA_Channel_Common
Module3=DMA_0_Short_Address_Mode
...
Module42=Bus_Controller
Module43=System_Control
Module44=Interrupt_Controller

 ...

[DMA_Channel_Common]
reg0=regDMAWER
reg1=regDMATCR
reg2=regDMABCRH/SAM
reg3=regDMABCRL/SAM
reg4=regDMABCRH/FAM
reg5=regDMABCRL/FAM
dep= regMSTPCRH 7 0

...
[regDMAWER]
id=DMAWER 0xffff00 B A H dmawer_bitfields

...

[dmawer_bitfields]
bit0=WE0A
bit1=WE0B
bit2=WE1A
bit3=WE1B

モジュールモジュールモジュールモジュール

コメントコメントコメントコメント

レジスタ名レジスタ名レジスタ名レジスタ名

サイズサイズサイズサイズ

絶対アドレスフラグ絶対アドレスフラグ絶対アドレスフラグ絶対アドレスフラグ

アドレスアドレスアドレスアドレス

フォーマットフォーマットフォーマットフォーマット

ビットフィールドビットフィールドビットフィールドビットフィールド

レジスタ名レジスタ名レジスタ名レジスタ名

ビットビットビットビット

値値値値

ビットビットビットビット
フィールドのフィールドのフィールドのフィールドの
定義定義定義定義

モジュールモジュールモジュールモジュール
の定義の定義の定義の定義

レジスタのレジスタのレジスタのレジスタの
定義定義定義定義
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付録付録付録付録 F F F F シンボルファイルのフォーマットシンボルファイルのフォーマットシンボルファイルのフォーマットシンボルファイルのフォーマット
HDIがシンボルファイルを正しく理解しデコードするためには、決められた
方法でファイルをフォーマットする必要があります。

1. ファイルは、ASCIIテキストファイルでなければなりません。
2. ファイルの先頭には、“BEGIN”という語を指定する必要があります。
3. 各シンボルは、別個の行にあり、最初に“H”で終わる 16 進数の値、続
いてスペース、次にシンボルテキストが指定されていなければなりま
せん。

4. ファイルの終わりには、“END”という語を指定する必要があります。

例:
BEGIN
11FAH Symbol_name_1
11FCH Symbol_name_2
11FEH Symbol_name_3
1200H Symbol_name_4
END
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索引
About HDI.............................................................................................................................................. 72
Acquisition ............................................................................................................................................. 91
Add .............................................................................................................................................73, 79, 83
Add Range.............................................................................................................................................. 86
Add Watch......................................................................................................................40, 41, 77, 89, 93
Address.......................................................................................................................................76, 79, 88
Analysis Enabled ................................................................................................................................... 86
Arrange Icons...................................................................................................................................54, 72
ASCII................................................................................................................................................3, 125
Assembler............................................................................................................................................... 16
BP .....................................................................................................................................................79, 88
Breakpoint/Event Properties ..........................................................................................................35, 73
Breakpoints..............................................................................................................33, 34, 35, 36, 67, 73
Cascade ............................................................................................................................................55, 72
Clear ....................................................................................................................................................... 92
Close All ................................................................................................................................................. 72
Code and Assembler .............................................................................................................................. 76
Command Line................................................................................................................... 67, 74, 97, 100
Compare ...........................................................................................................................................70, 85
Configure Map ................................................................................................................................... 8, 70
Configure Overlay ................................................................................................................................. 70
Configure Platform................................................................................................................8, 9, 71, 121
Copy........................................................................................................66, 70, 76, 78, 82, 85, 87, 90, 93
Copy Memory ...................................................................................................................................26, 70
Customize...................................................................................................................................59, 60, 71
Cut .......................................................................................................................................................... 66
Delete .........................................................................................................................................73, 80, 93
Delete All....................................................................................................................................73, 80, 93
Delete All Ranges .................................................................................................................................. 86
Delete Range.......................................................................................................................................... 86
Description ............................................................................................................................................. 58
Disable/Enable....................................................................................................................................... 74
Disassembly .......................................................................................................16, 29, 30, 53, 56, 67, 75
Edit .....................................................................................................9, 23, 35, 46, 66, 73, 78, 79, 83, 87
Edit Range ............................................................................................................................................. 86
Edit Value ..................................................................................................................................42, 82, 93
Evaluate ................................................................................................................................................. 67
Exit ...................................................................................................................................................62, 66
Expand/Collapse .................................................................................................................................... 78
File..............................................................................................................................................11, 35, 61
File Filter ............................................................................................................................................... 60
Fill ....................................................................................................................................................70, 85
Fill Memory......................................................................................................................................70, 85
Filter....................................................................................................................................................... 91
Find ....................................................................................................................66, 67, 70, 80, 85, 89, 91
Find Next ............................................................................................................................................... 91
Font ........................................................................................................................................................ 59
Go....................................................................................................................................29, 34, 37, 38, 68
Go To Cursor..................................................................................................................30, 37, 68, 77, 89
Go To Disassembly ................................................................................................................................ 90
Go To Source .......................................................................................................................................... 74
Halt.............................................................................................................................................33, 69, 91
HDI Options.....................................................................................................................................62, 71
HDIセッションファイル ....................................................................................................................... 61
Help ..............................................................................................................................................4, 72, 83
I/O Area.................................................................................................................................................. 67
I/O Registers ................................................................................................................47, 48, 67, 77, 121
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Index....................................................................................................................................................... 72
Initialize ................................................................................................................................................. 66
Instant Watch ......................................................................................................................39, 40, 77, 89
Label .................................................................................................................................................76, 88
Labels .........................................................................................................................................17, 67, 78
Line......................................................................................................................................................... 88
Load............................................................................................................................................69, 81, 84
Load Memory ......................................................................................................................................... 28
Load Program ............................................................................................................................11, 12, 66
Load Session ....................................................................................................................................61, 65
Locals..........................................................................................................................................43, 67, 82
Logging................................................................................................................................................... 75
Memory ..................................................................................8, 21, 23, 25, 26, 27, 47, 51, 59, 67, 69, 84
Memory Mapping...................................................................................................................9, 10, 70, 83
Minimize ................................................................................................................................................ 53
Name ...................................................................................................................................................... 79
New......................................................................................................................................................... 57
New Session ........................................................................................................................................... 65
Next ........................................................................................................................................................ 55
Open ....................................................................................................................................................... 68
Open Memory Window....................................................................................................................21, 67
Options .............................................................................................................................................62, 71
Overlay .............................................................................................................................................49, 50
Paste ....................................................................................................................................................... 66
PC ............................................................................ 19, 29, 37, 38, 46, 67, 68, 69, 77, 89, 103, 111, 118
Performance Analysis......................................................................................................68, 86, 102, 103
Play......................................................................................................................................................... 75
Radix ..........................................................................................................................3, 42, 64, 71, 82, 93
Refresh ................................................................................................................................................... 69
Register ..........................................................................................................................................46, 122
Registers.....................................................................................................................................44, 68, 87
Reset ....................................................................................................................................................... 83
Reset Counts/Times............................................................................................................................... 86
Reset CPU.............................................................................................................................................. 68
Reset Go ...............................................................................................................................29, 37, 38, 68
Restart.................................................................................................................................................... 91
Restore.................................................................................................................................................... 53
Run ...........................................................................................................................29, 30, 31, 33, 68, 69
Run Batch File....................................................................................................................................... 74
Run Program..............................................................................................................................37, 51, 69
Save ................................................................................................................................27, 70, 81, 85, 92
Save As................................................................................................................................................... 81
Save Memory ......................................................................................................................................... 27
Save Session.....................................................................................................................................61, 65
Save Session As ...............................................................................................................................61, 65
Search...............................................................................................................................................24, 85
Search for Help on ................................................................................................................................. 72
Select Function ............................................................................................19, 23, 37, 51, 52, 76, 84, 89
Select Session....................................................................................................................................... 7, 8
Set Address ..............................................................................................................19, 23, 51, 76, 84, 89
Set Line .................................................................................................................................................. 89
Set Log File ............................................................................................................................................ 75
Set PC Here .....................................................................................................................................77, 89
Set PC To Cursor ................................................................................................................................... 69
Setup ..................................................................................................3, 8, 49, 56, 59, 60, 62, 64, 71, 121
Snapshot................................................................................................................................................. 92
Source.......................................................... 15, 19, 20, 29, 30, 34, 37, 39, 40, 46, 51, 59, 68, 76, 87, 88
Status ...............................................................................................................................................10, 68
Status Bar ........................................................................................................................................56, 71
Step......................................................................................................................................................... 69
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Step In ..............................................................................................................................................31, 69
Step Out ...........................................................................................................................................31, 69
Step Over ...................................................................................................................................31, 32, 69
Step Program ...................................................................................................................................31, 69
System Status......................................................................................................................10, 11, 68, 90
Test ...................................................................................................................................................70, 85
Test Memory ........................................................................................................................26, 27, 70, 85
Tile....................................................................................................................................................55, 72
Toggle Bit ............................................................................................................................................... 87
Toolbar .............................................................................................................................................56, 71
Tooltip Watch......................................................................................................................................... 39
Trace.................................................................................................................................................68, 91
Trim Source............................................................................................................................................ 92
Update.................................................................................................................................................... 90
Use as Default Font............................................................................................................................... 59
Using Help ............................................................................................................................................. 72
Verify ...................................................................................................................................................... 70
View............................................................................................10, 15, 16, 17, 21, 34, 40, 43, 44, 47, 67
View Source............................................................................................................................................ 92
Watch .....................................................................................................39, 40, 41, 43, 68, 77, 89, 92, 93
Window................................................................................................................................................... 72
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